
 
 
 
 
 
 
 
 

Please Read 
 

The L&TT Support Guide (End User edition) is intended to be used as an 
interactive help file, allowing access to topics, email addresses, web sites, 

searching, and so on. The help file is a compiled Microsoft® HTML Help system 
and requires Internet Explorer 4.X or later to view and run it on your computer. 
This browser is included with most Windows® operating systems. Windows 95 

and Windows NT® users need to install it. 
Access the help file at: 

ftp://ftp.hp.com/pub/information_storage/software/ltt/LTT_Support_GuideEUE.chm. 
 

If you do not have the browser installed, use this PDF. Note, however that this 
PDF does not provide interactive functionality.  
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Welcome 

Welcome to the L&TT v3.5 SR1 Support Guide (End User 
Edition) 
Welcome to the L&TT Support Guide (End User Edition). This document has been developed to provide assistance and 
guidance to those using the HP Library & Tape Tools (L&TT) diagnostic to investigate and resolve user problems with HP 
nearline products. 

Note: Before you use L&TT, ensure that any backup applications or other services that try to access the drive or library 
you are about to test are disabled or shut down. See Device access issues for further details. 

Within this support guide you will find information on: 

 Supported OS platforms 

 Installation Requirements (for HP-UX, Linux, Linux Advanced Server, Novell NetWare, 
OpenVMS, Tru64 UNIX®, and Microsoft® Windows®), as well as the L&TT application 
download link. 

 Typical Installation Sequences (for HP-UX, Linux, Linux Advanced Server, NetWare, 
OpenVMS, Tru64 UNIX, and Windows) 

 Getting Started on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX and Windows. 
This section also includes information on Setting software preferences and passwords, 
Using L&TT in SAN environments, Using the Skip-Scan feature, Running installation 
checks, and Device access issues. 

 Firmware Functions (such as downloading/updating firmware files on HP-UX, Linux, 
NetWare, OpenVMS, or Tru64 UNIX and Windows). 

 Available Test Functions (Diagnostic tests and Performance tests) 

 Support tickets 

 Common questions and scenarios (Device and media support/compatibility, L&TT 
installation and usage, and so on) 

 Miscellaneous L&TT issues (Useful links, Windows links, Backup software support links, 
L&TT change highlights per version, Support for the L&TT tool, and Restricted Mode) 

Note: Information is structured in a Help file format and is designed to be used as an online document. It has numerous 
document links to facilitate finding the desired information quickly and easily. To determine the actual URL of an external 
link, right-click the hyperlink in the support guide, and then click Properties. If you want a hard copy of the support guide, 
a PDF is available for download. If you only want to print a particular section of the support guide, you can do so directly 
from the online help file. To print a single section, expand any links in the section you are going to print to be sure the 
hidden information is visible prior to printing. Then, click the Print button on the main menu bar, select a topic or select to 
include all subtopics, and then click OK. 

! IMPORTANT: As a user of the Support Guide, you have an opportunity to make it more useful by sending comments 

and information you believe would benefit others. You should also send feedback if you note any problems in the Support 
Guide, such as a broken link, so that we can correct the problem. To send feedback, click here. For proper routing of your 
feedback, please make sure to include the words "L&TT Support Guide" in the subject line of your email. 

Legal Notice 

HP StorageWorks Library and Tape Tools v3.5 SR1 Support Guide (End User Edition) 
Third Edition (September 2004) 
Part Number: 5697-5211  
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Alerts and updates 
This support guide will be updated periodically to include new device support, new L&TT application features, and so on. 
To ensure that you are made aware of new Support Guide releases, HP recommends that you sign up for driver, patch, 
security and support alerts by clicking http://h30046.www3.hp.com/subprofile.php?SUBS=DRIVERSIGNUP>. If you have 
already signed up for these notifications, you need not sign up again.  
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Legal notice 
© Copyright 2003-2004 Hewlett-Packard Development Company, L.P. 

Hewlett-Packard Company makes no warranty of any kind with regard to this material, including, but not limited to, the 
implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not be liable for errors 
contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this 
material. 

This document contains proprietary information, which is protected by copyright. No part of this document may be 
photocopied, reproduced, or translated into another language without the prior written consent of Hewlett-Packard. The 
information contained in this document is subject to change without notice. 

Compaq Computer Corporation is a wholly-owned subsidiary of Hewlett-Packard Company. 

Microsoft®, MS-DOS®, MS Windows®, Windows®, and Windows NT® are U.S. registered trademarks of Microsoft 
Corporation. 

UNIX® is a registered trademark of The Open Group. 

Hewlett-Packard Company shall not be liable for technical or editorial errors or omissions contained herein. The 
information is provided “as is” without warranty of any kind and is subject to change without notice. The warranties for 
Hewlett-Packard Company products are set forth in the express limited warranty statements for such products. Nothing 
herein should be construed as constituting an additional warranty. 

HP StorageWorks Library and Tape Tools v3.5 SR1 Support Guide (End User Edition) 

Third Edition (September 2004) 

Part Number: 5697-5211   
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Operating System Platforms Support 

Operating system platforms support 

 HP-UX 11.x 

 Linux RedHat 7.2 

 Linux RedHat 7.3 

 Linux RedHat 8.0 

 Linux RedHat 9.0 

 Linux RedHat Advanced Server 2.x 

 NetWare 5x 

 NetWare 6.x 

 OpenVMS 

 Tru64 UNIX 5.x 

 Windows 95 SE, Windows 98, Windows ME 

 Windows NT4  (SP 3 required, SP 6 recommended) 

 Windows 2000 

 Windows XP 

 Windows Server 2003 
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Installation Requirements 

About OS installation requirements 
Click the links below to access installation details on the following supported operating systems: 

 HP-UX 

 Linux 

 Linux Advanced Server 

 NetWare 

 OpenVMS 

 Tru64 UNIX 

 Windows 
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Installation requirements for HP-UX 

HP-UX installation requirements 

Item Description 

Download link http://www.hp.com/support/tapetools 

Download size 17.6 MB (HPUX Depot format) 

Download time (typical) <3 minutes (T1) to 50 minutes (56K) 

Install time (typical) <3 minutes 

Reboot requirements None 

Software dependencies / prerequisites  Devices do not need to be claimed by the 
operating system with ioscan for L&TT to access 
them. 

 The sctl driver must be installed for L&TT to 
access the device you want to test (more info).  

L&TT builds its own pass-through SCSI device 
files using the sctl driver, so that driver must 
be installed; however, L&TT does not need 
the operating system to list any of the devices 
as "CLAIMED." They may be listed that way (if 
the appropriate driver is installed), but they 
don't need to be for L&TT to fully access them 
(beginning with L&TT v3.3). 

 Devices must NOT be listed as "NO HARDWARE" 
in ioscan (more info).  

If the device you want to test with L&TT is 
listed as "NO HARDWARE" in ioscan, the 
communication path between the host and the 
device is not working and must be fixed before 
L&TT will be able to communicate with the 
device. 

Installation problems 
None 

Typical installation sequence See Typical installation sequences for an example of a 
typical installation sequence with screen shots. 
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Installation requirements for Linux 

Linux 7.x, 8.x, 9.x installation requirements 

Item Description 

Download link http://www.hp.com/support/tapetools 

Download size 6.1 MB 

Download time (typical) 1 minute (T1) to 20 minutes (56K) 

Install time (typical) <3 minutes 

Reboot requirements None 

Software dependencies / prerequisites  Device should be recognized by proc/SCSI 
subsystem. 

 Device drivers for the connected tape 
devices/libraries or default device driver should 
be present. 

Installation problems None  

Typical installation sequence See Typical installation sequences for an example of a 
typical installation sequence with screen shots. 
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Installation requirements for Linux Advanced Server 

Linux Advanced Server installation requirements 

Item Description 

Download link http://www.hp.com/support/tapetools 

Download size 7.2 MB 

Download time (typical) 1 minute (T1) to 25 minutes (56K) 

Install time (typical) <3 minutes 

Reboot requirements None 

Software dependencies / prerequisites  Device should be recognized by proc/SCSI 
subsystem. 

 Device drivers for the connected tape 
devices/libraries or default device driver should 
be present. 

Installation problems None 

Typical installation sequence See Typical installation sequences for an example of a 
typical installation sequence with screen shots. 
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Installation requirements for NetWare 

NetWare installation requirements 

Item Description 

Download link http://www.hp.com/support/tapetools 

Download size 5.7 MB 

Download time (typical) 1 minute (T1) to 20 minutes (56K) 

Install time (typical) <2 minutes 

Reboot requirements None 

Software dependencies / prerequisites  Device should be recognized by NWPA 
subsystem. 

 Device drivers for the connected tape 
devices/libraries or default device driver should 
be present. 

 L&TT on NetWare currently does not support 
clustering configurations. 

Installation problems None 

Typical installation sequence See Typical installation sequences for an example of a 
typical installation sequence with screen shots. 
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Installation requirements for OpenVMS 

OpenVMS installation requirements 

Item Description 

Download link http://www.hp.com/support/tapetools 

Download size 19.6 MB 

Download time (typical) <3 minutes (T1) to 55 minutes (56K)  

Install time (typical)  <4 minutes  

Reboot requirements None 

Software dependencies / prerequisites Installation of the initial release of L&TT v3.5 was 
supported on OpenVMS v7.3-2 only. If you attempted to 
install on v7.3-1 you would either get "pthread" errors, or 
be informed of the incompatibility when attempting to 
install on OpenVMS v7.3-1. This problem was solved 
with an update to v3.5 posted on the web July 9, 2004 
which supports both OpenVMS versions. If you are 
running on v7.3-1 and haven't tried to download and 
install L&TT since that date, you should do so now. 

The Terminfo database must be installed, and the 
Terminfo environment set up prior to installing L&TT, 
otherwise L&TT will not install properly. If you 
downloaded and installed L&TT from the HP web site 
after June 17, 2004 the Terminfo database was 
automatically installed during the L&TT installation. If 
you downloaded and installed prior to this date, 
download and install the latest version to ensure that the 
Terminfo database is correctly installed. 

If you are using GNV, click here for instructions on 
setting up the environment variable. 

 Set the Term to vt100 using the 
following command at the bash 
prompt: 

"export TERM=vt100" 

 Set the TERMINFO environment 
variable to indicate the directory path 
of the Terminfo database. If the 
Terminfo database is installed at 
/usr/local/share/terminfo, use the 
following command to set the 
TERMINFO variable: 

"export 
TERMINFO=/usr/local/share/termin
fo" 

 

If you are using DCL, click here for instructions on 
setting up the environment variable. 

 Set the Term to vt100 using the 
following command: 
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"set term  /dev=vt100" 

 If the Terminfo database is installed 
at 
sys$device:[usr.local.share.terminfo], 
use the following command to create 
a logical name USR: 

"define usr sys$device:[usr]" 

 

Note: DCL is the abbreviation for DIGITAL Command 
Language which is the default command interpreter for 
OpenVMS. GNV was developed to provide a "UNIX-like" 
environment on OpenVMS to make it easier for Unix 
users to use OpenVMS. GNV is a separate installation 
that the user must install explicitly. 

Installation problems None 

Typical installation sequence See Typical installation sequences for an example of a 
typical installation sequence with screen shots. 
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Installation requirements for Tru64 UNIX 

Tru64 UNIX installation requirements 

Item Description 

Download link http://www.hp.com/support/tapetools 

Download size 7.4 MB 

Download time (typical) 1 minute (T1) to 25 minutes (56K) 

Install time (typical) <3 minutes 

Reboot requirements A reboot occurs only if hardware manager failed to 
recognize the connected device. 

Software dependencies / prerequisites  Device should be recognized by hardware 
manager and SCU subsystem. 

 Device drivers for the connected tape 
devices/libraries or default device driver should 
be present. 

 L&TT on Tru64 UNIX currently does not support 
clustering configurations. 

Installation problems None 

Typical installation sequence See Typical installation sequences for an example of a 
typical installation sequence with screen shots. 
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Installation requirements for Windows 

Windows installation requirements 

Item Description 

Download link http://www.hp.com/support/tapetools 

Download size 10.6 MB (InstallShield bundle for v3.4 SR1) 

Download time (typical) <2 minutes (T1) to 30 minutes (56K) 

Install time (typical) 1-5 minutes 

Reboot requirements  If you select and install the ASPI component, you 
are prompted to reboot. ASPI is required with 
Windows 9x, but is not generally recommended 
for other Windows versions. 

 If you are running a version of Internet Explorer 
other than 4 SP2 or later, a reboot occurs to 
update Windows Common Control Library. 

Software dependencies / prerequisites Device drivers for the connected tape devices/libraries 
or default device driver should be present. 

Note: L&TT can be run from the CD ROM. 

Installation problems Beginning with L&TT v3.4 SR1, the installation will not 
proceed if a previous version of L&TT is detected. If 
this occurs, go to the L&TT product page, click the link 
for the Windows operating system you are running, and 
then click the "HP StorageWorks Library and Tape 
Tools Install Support Setup link" to download the 
hp_ltt_install_support.exe utility. Once downloaded, run 
this utility to clean up all old install files, and then retry 
the L&TT installation procedure.  

When downloading the L&TT application from the web 
to your local system, make sure you name the 
download folder to something other than "HP 
StorageWorks Library and Tape Tools" or the 
installation will fail if you attempt to install from that 
folder.  The failure error will indicate that a different 
instance of the installer is already running. 

Typical installation sequence See Typical installation sequences for an example of a 
typical installation sequence with screen shots. 
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Installation Sequences 

Typical installation sequence for HP-UX 
This section contains sample screen captures of a typical installation on an HP-UX operating system.  

To install L&TT for HP-UX: 

1. Log in as root. 

2. Navigate to the temporary directory: 

cd /tmp  

3. Download or copy the L&TT tar file (hp_ltt<xx>.tar, where <xx> is the version number) to 
this directory. If you are copying the file from a different location, enter the following 
(substitute the directory in which the file currently resides for <directory name>): 

cp /<directory name>/hp_ltt<xx>.tar /tmp 

4. Untar the L&TT tar file: 

tar -xvf hp_ltt<xx>.tar 

(show me) 

 

5. Run the install script in the /tmp directory: 

./install_hpltt<xx> 

(show me) 



Installation Sequences 

15 

 

6. After the software is successfully installed, enter the following commands to remove the 
/tmp/ltt directory and its contents: 

cd /tmp 

rm -rf ltt 

rm -rf install_hpltt 
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Typical installation sequence for Linux 
This section contains sample screen captures of a typical installation on a Linux operating system.  

To install L&TT for Linux: 

1. Log in as root. 

2. Navigate to the temporary directory: 

cd /tmp 

3. Download or copy the L&TT tar file, hp_ltt<xx>.tar (where <xx> is the version number) to 
this directory. If you are copying the file from a different location, enter the following 
(substitute the directory in which the file currently resides for <directory name>): 

cp /<directory name>/hp_ltt<xx>.tar /tmp 

4. Untar the L&TT tar file: 

tar -xvf hp_ltt<xx>.tar 

(show me) 

 

5. Run the install script in the /tmp directory: 

./install_hpltt<xx> 

(Show me) 
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6. After the software is successfully installed, enter the following commands to remove the 
/tmp/ltt directory and its contents: 

cd /tmp 

rm -rf ltt 

rm -rf install_hpltt 
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Typical installation sequence for NetWare 

To install L&TT for NetWare: 

1. Download the L&TT for NetWare file to a temporary directory. 

2. From a client workstation, use any standard unzip utility (subject to condition described in 
the note below) to extract the file to the SYS:System\ directory on the NetWare server. 
Make sure that the option to create a directory is enabled in the archiving software. 

Note: Use WinZip to unzip the archive, as it has been used extensively in L&TT testing. Do not use the unzip NLM that 
comes with later versions of NetWare, as it has not been tested and approved.  
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Typical installation sequence (OpenVMS) 
This section contains sample screen captures of a typical installation on an OpenVMS operating system.  

To Install L&TT for OpenVMS: 

1. Log in as "system" (if not already logged in). 

2. After you have downloaded hp-axpvms-ltt-y<xx>-1.pcsi (where <xx> is the version 
number) to a directory on your hard disk, navigate to that directory and enter the following 
command to start the installation: 

"product install" 

The system responds with "_product name (* to show list)". (show me) 

 

3. Enter an asterisk (*) to display a list of applications available for installation. 

The system displays "HP AXPVMS LTT Vx.x" and any other applications available for installation. The "x.x" 
displays the version of L&TT. 

4. If "HP AXPVMS LTT Vx.x" is the only installation, it is indicated as being selected for 
installation, and you are asked to continue. Enter a carriage return for the default "yes" 
response. If more than one application is available for installation, each is listed along 
with a corresponding number. Enter the number associated with the L&TT installation to 
select it, and then enter yes to start the installation. 

5. The L&TT installation begins. The progress is indicated (show me). 
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The installation process creates the directory structure opt.ltt in sys$sysdevice:[vms$common] in which all of the 
L&TT files are installed. 
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Typical installation sequence for Tru64 UNIX 
This section contains sample screen captures of a typical installation on a Tru64 UNIX operating system.  

To install L&TT for Tru64 UNIX: 

1. Log in as root. 

2. Navigate to the temporary directory: 

cd /tmp 

3. Download or copy the L&TT tar file, hp_ltt<xx>.tar (where <xx> is the version number) to 
this directory. If you are copying the file from a different location, enter the following 
(substitute the directory in which the file currently resides for <directory name>): 

cp /<directory name>/hp_ltt<xx>.tar /tmp 

4. Untar the L&TT tar file: 

tar -xvf hp_ltt<xx>.tar 

(show me) 

 

5. Run the install script in the /tmp directory: 

./install_hpltt<xx> 

(show me) 
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6. After the software is successfully installed, enter the following commands to remove the 
/tmp/ltt directory and its contents: 

cd /tmp 

rm -rf ltt 

rm -rf install_hpltt 
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Typical installation sequence for Windows 
This section contains sample screen captures of a typical installation on a Windows operating system.  

To install L&TT for the current version of windows: 

1. Download or copy the self-extracting executable file to a temporary location. 

2. Double-click the self-extracting executable file to launch the installer. 

The InstallShield Welcome page opens. 

 

3. Click Next. 

The License Agreement page opens. 
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4. Read the program license agreement and click Yes if you agree to and accept the terms 
of the license agreement. 

The "Read Me" File page opens. 

 



Installation Sequences 

25 

5. Read the Read Me file for any last-minute changes to the documentation, and then click 
Next. 

The Select Features page opens. 

 

Notes: 

 In most cases, the default settings of this page are adequate. Windows NT 4.0, 
Windows 2000, and Windows XP users have the option to install Advanced 
SCSI Programming Interface (ASPI) support. On Windows 2003, ASPI 
installation is not an available option from the L&TT install. This is due to the 
complex nature of the installation related to additional 64 bit restrictions for 
modifying the registry. However, you can acquire ASPI separately from Adaptec 
and install it per their installation process. If you do this, L&TT will be able to 
use it. With Windows 9x installations, the ASPI component is required and 
automatically included in the L&TT installation process. HP recommends that 
you not install ASPI support for other versions of Windows. 

  ASPI support is beneficial when installed storage applications cannot be shut 
down and those applications have locked access to the device through the 
Miniport driver. If ASPI is installed, it is generally not necessary to shut down 
these applications to access devices through L&TT (although the applications 
should not be accessing the devices while L&TT is running). ASPI lets you run 
L&TT on a locked device without rebooting; however, a reboot is required after 
installing ASPI. 

6. Select the desired components to install, and then click Next. 

The Choose Destination Location page opens. 
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7. Select a destination location to install the program. You can accept the default location or 
click Browse to install to a different location. After choosing the destination location, click 
Next. 

The Select Program Folder page opens. 
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8. Indicate the program directory in which you want the setup program to create program 
icons. Click Next. The program directory is created in the Programs directory of the Start 
menu. 

The Ready to start installation process page opens. 

 

9. Click Next to install L&TT. If you need to review or change installation settings, click 
Back. 

10. The wizard installs L&TT, and then displays the Installation is Complete page to confirm the 
installation. 
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11. Click Finish to close the InstallShield wizard. 
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Getting Started (Setup and Problems) 

Setup 

Getting started on Windows 

1. To start L&TT, double click the L&TT icon on the desktop (if present) or click Start > 
Programs > HP StorageWorks Library and Tape Tools > HP L&TT.  

The initial splash screen opens.  

2. In the splash screen, you have a choice of selecting one of the two I/O modes that L&TT 
supports: 

 NT Miniport: This mode is the default and uses an interface that is native to 
Windows NT 4.0, 2000, XP, and Windows Server 2003. This is the preferred I/O 
mode when available because it does not require the installation of the ASPI 
interface. However, there are some limitations to the Windows NT Miniport I/O 
mode related to using devices that are “claimed” by other applications, or that are 
used with non-standard OS drivers. In those cases, selecting the ASPI I/O mode 
may make a device accessible. 

Note: The Windows NT Miniport I/O mode is not available on Windows 9x. 

 ASPI: This mode uses an optional I/O programming interface that is available on all 
versions of Windows. This I/O mode can be used with any Windows operating 
system. If you want to run in ASPI mode, and you are not running Windows 9x, you 
will need to install it. HP recommends that you not install ASPI unless running on 
Windows 9x, or unless directed to do so by HP support personnel. ASPI installation 
is not an option via L&TT with Windows 2003. For details on this and other ASPI 
installation information, click here. 

Note: If running L&TT v3.5 or later, see Using the Scan Mode Selection feature to learn about scan options. 

3. Make sure that the Windows Removable Storage Manager (RSM) service is disabled. 
RSM should only be enabled if you are using the Windows native backup application. If 
you are not using the Windows native backup application, disable RSM to avoid issues 
during testing. 

4. Begin using L&TT. 

Note: The various windows and dialog boxes for the Windows operating systems are self-explanatory, so they 
are not included here. 
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Getting started on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

Note: The screen captures that appear in this section were taken on a Linux system, but apply to HP-UX, NetWare, 
OpenVMS, and Tru64 UNIX, unless otherwise specified. Note that the screen captures are examples only; the content of 
user windows varies. 

To launch L&TT on HP-UX, Linux, or Tru64 UNIX: 

Log on as root and execute the following commands: 

cd  /opt/ltt 

./hp_ltt 

Note: If running L&TT v3.5 or later, see Using the Scan Mode Selection feature. 

To launch L&TT on NetWare: 

 Execute the following command from the server console: 

hp_ltt\hp_ltt 

Note: If running L&TT v3.5 or later, see Using the Scan Mode Selection feature. 

To launch L&TT on OpenVMS: 

1. Use the following command to define the logical name USR so that it points to the 
directory sys$sysdevice:[vms$common.opt.ltt.misc.usr]: 

define usr sys$sysdevice:[vms$common.opt.ltt.misc.usr] 
  

2. Navigate to the sys$sysdevice:[vms$common.opt.ltt] directory and execute the following 
command: 

run HP_LTT.EXE 

Note: If running L&TT v3.5 or later, see Using the Scan Mode Selection feature. 

 

To navigate L&TT on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

Note: If running L&TT v3.5 or later, see Using the Scan Mode Selection feature. 

1. After L&TT launches, an Information screen is displayed, offering basic information about 
navigating the screens. 
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2. Press any key to proceed beyond this screen and start the device scan. L&TT then scans 
the system for connected devices. 

3. When the scan is complete, the Main screen is displayed. The top of each screen displays 
the current screen name in hierarchical format, with each screen level separated by the 
“>” character. On most screens, pressing Enter without typing other text (blank 
command), displays a Command Help screen. 
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4. On the Command Help screen, enter an available command by entering the number of 
the command, or by entering the name of the command and pressing Enter. Entering the 
number of a command only works from a Command Help screen. To exit a Command 
Help screen, enter a blank command (press Enter).  

Note: Some commands require an argument. If you enter a command that requires an argument and you do not 
include one, or if you use an invalid argument, an error message opens. 

Example 1: Selecting the first device 

If you want to select the first device from the device list, the syntax is: 
 
select 1 
 
As an example, if you enter select 1 in the Command Help screen or in the previous Main screen after the scan, the 
following Device Information screen is displayed. Alternatively, you can omit the select command and only enter the 
device number from the main screen. 
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In this particular example, the drive did not have a tape loaded so there was no cartridge information to display. If a data 
cartridge had been loaded, information regarding cartridge type, capacity, and write-protect status would have been 
displayed. To see a list of compatible media that can be used with this device, use the cartridge command. 

If the device you selected was an automation device (library or autoloader) rather than a standalone device, a similar 
screen opens. However, instead of displaying “Drive Information” in the top of the screen, it displays “Identity.” Other 
differences are the addition of “Model Name,” “Number of Slots,” and “Number of Drives” information, and the lack of 
“OBDR Capability” status in the automation screen. Also, with an automation device, the cartridge command displays the 
slot inventory of the library. It displays which slots and drives currently have cartridges loaded, as well as the cartridge 
barcode, if available and applicable. 

Example 2: Entering a blank command 

If you issue a blank command in the above standalone Device Information screen (press Enter), the Device 
Information Command Help screen is displayed, displaying the other available commands from this screen, in addition 
to the cartridge command.  
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Setting software preferences and passwords 

You can set certain software preferences to control various elements of L&TT. By choosing the preferences accordingly, 
you can configure L&TT to provide more or less interactive status as desired. Setting of software preferences is supported 
for both Windows and non-Windows environments, although certain parameters are only available for Windows. 

 

Windows 

To set preferences for L&TT on Windows: 

1. Click options > preferences from the menu bar. 

The Preferences dialog box opens. 

 

2. Configure the following preferences: 

 Show Scan Details: Displays SCSI bus scanning process in the device list screen 
when L&TT is first started. Disabled by default. 

 Show Instructions: Displays instructions in the device list screen. These 
instructions provide information corresponding to the function displayed in the Main 
screen. This can be helpful especially for novice users. More experienced users 
may want to disable this option. 
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 Firmware File Path: Displays the location where L&TT stores and accesses 
firmware files on your local system. When using Get Files From Web feature, 
firmware files are downloaded to this directory. 

 Log File Path: Displays the location where L&TT stores and accesses log files on 
your local system. Support and event logs are stored here. 

 Script File Path: Displays the location where L&TT stores and accesses device 
analysis rules files. There is also the default locations for SCSI scripts.  

Note: For the above three "path" options, the default location of the directory is the L&TT installation directory. 

 Display initial dialog at startup to choose I/O mode etc.: Displays the L&TT 
splash screen when started. I/O mode and other options can be selected from the 
splash screen. 

 Check for updates on the web:  L&TT uses an available internet connection to 
look for product updates such as firmware upgrades, new device analysis rules, 
and new versions of L&TT. L&TT performs this check once every 24 hours, when 
enabled and L&TT is running.  This can be a valuable feature to automatically keep 
users informed of available updates when L&TT is started. 

 Display dialogs for I/O pending more than 2 minutes: Displays a status update 
dialog box during long SCSI operations. 

 Check for redundant devices after scan: Checks for redundant devices in the 
current configuration. This option is enabled by default. 

 Add I/O history to Event Log: Logs all SCSI commands sent or received into a log 
file. This option requires a large amount of disk space and should only be used 
when requested by qualified HP personnel to aid in debugging of a potential L&TT 
issue. See also Generating event logs. 

 Data phase limit for I/O history: Limits the amount of data recorded to the log file 
for each SCSI command to the number of bytes specified (default 128 bytes). To 
specify a different limit, enter any positive number. For no limit, enter unlimited.  

 Enter maximum e-mail size and E-mail size limit: L&TT defaults to 10 MB for 
maximum size for any email. If your email setup will not permit email files as large 
as 10 MB, click the check box for maximum email size, and then enter a smaller 
number. If you attempt to email a support ticket using L&TT that is larger than the 
selected maximum email size, L&TT breaks the email into smaller, separate emails 
so that they do not exceed the maximum size limit.  

To set a password for L&TT on Windows: 

Note: Passwords are available only by contacting HP support, and should only be used under the direction of HP support 
personnel. 

Click options > enable factory overrides, and then enter the password when prompted. This allows you to enter 
certain password-protected options. Passwords are available only by contacting HP support, and should only be 
used under the direction of HP support personnel. 

 

HP-UX, Linux, NetWare, OpenVMS, and Tru64 UNIX 

Note: Passwords are available only by contacting HP support, and should only be used under the direction of HP support 
personnel. 

To set preferences and passwords for L&TT on HP-UX, Linux, OpenVMS, NetWare, or Tru64 UNIX: 

1. In the L&TT main screen, enter preferences. 

The Preferences screen is displayed. 
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2. Configure preferences. (Current values are shown for each preference option.) 
Preference options include: 

 Firmware File Path: Displays the location where L&TT stores and accesses 
firmware files on your local system. When using Get Files From Web feature, 
firmware files are downloaded to this directory.  

 Log File Path: Displays the location where L&TT stores and accesses log files on 
your local system. Support and event logs are stored here. 

 Script File Path: Displays the location where L&TT stores and accesses device 
analysis rules files. Also the default location for SCSI scripts.  

Note: For the above three "path" options, the default location of the directory is the L&TT installation directory. 

 Add I/O history to Event Log: Logs all SCSI commands sent or received into a log 
file. This option requires a large amount of disk space and should only be used 
when requested by qualified HP personnel to aid in the debugging of a potential 
L&TT issue. See also Generating event logs. 

 Data phase limit for I/O history: Limits the amount of data recorded to the log file 
for each SCSI command to the number of bytes specified (default 128 bytes). To 
specify a different limit, enter any positive number. For no limit, enter unlimited.  

 Check for redundant devices (redundantcheck): Checks for redundant devices 
in the current configuration. This is enabled by default. 

 Enter the proxy server name, to enable the webdownload tool. (Proxy): Displays the 
Proxy server name for Web downloads. 

 Enter the port number for the proxy. (Port): Displays the Port number for proxy. 
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 Enter the maximum email size in MB (emailsizelimit): L&TT defaults to 10 MB 
for maximum size for any email. If your email setup will not permit email files as 
large as 10 MB, enter a smaller number. If you attempt to email a support ticket 
using L&TT that is larger than the selected maximum email size, L&TT breaks the 
email into smaller, separate emails so that they do not exceed the maximum size 
limit. 

 Current password entered: Lets you to enter the factory password. (Passwords 
are available only by contacting HP support, and should only be used under the 
direction of HP support personnel.) Currently entered password is displayed to the 
right of the option. If no password entered, “not set” is displayed.  
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Running installation check at L&TT launch 

On Windows, L&TT can be run in installcheck mode to check the installation of specific devices. When run in this mode, 
L&TT performs several tests on each selected device to determine if the device is configured optimally. In addition, L&TT 
performs connectivity and configuration tests on all devices supported by L&TT that are configured on the system. These 
tests cannot be overridden. All tests performed during the installation check can also be run manually with L&TT. 

The installation check feature is only supported on the following devices (as of L&TT v3.5): 

 HP Ultrium drives (L&TT v3.4 and above) 

 HP SDLT 320 drive (L&TT v3.5 and above) 

 HP VS80 drive (L&TT v3.5 and above) 

After conclusion of the installation check, the results of each test are displayed along with any recommendations. 

To enable installcheck mode: 

1. Launch L&TT from a command prompt (Start > Run), and then enter the following into 
the Run dialog box: 

"C:\Program Files\HP StorageWorks Library and Tape Tools\HP_LTT.exe"  -o 
mode=installcheck 

Be sure to include the quotation marks as indicated in the command line. 

The Installation Check wizard opens.  

 

2. Select the device on which to run the installation check, and then click the Start 
Verification button to display the next screen of the installation check wizard. 
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3. Select any optional tests you want L&TT to perform (show me). Some tests may not be 
available for your configuration. 

 

4. Click Continue Verification to begin the installation check. 

The third screen of the Installation Check wizard indicates the progress of the installation check (show me). 
Selected tests are executed sequentially, and the progress of each test is displayed. 



L&TT Support Guide (End User Edition) 

42 

 

The final screen of the Installation Check wizard displays the results of the selected tests and any 
recommendations. 
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Note: If you need to stop the installation check, click Abort Installation Check. The test is aborted after 
completing the current phase of the test. 

5. Click OK to close the installation check wizard. Closing the wizard also closes L&TT. If 
you want to restart L&TT, launch it as you normally would, without the 
“mode=installcheck” argument. 
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Miscellaneous configuration information 

Because document locations and content often change, direct links to content are not provided here to minimize problems 
with obsolete links. Go to www.hp.com and follow the links to the support page for your particular device to access related 
documents. 
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Using L&TT in SAN Environments 

About using L&TT in SAN environments 

With L&TT v3.3, the Skip-Scan feature was introduced to allow the user to skip the initial scan of the entire subsystem that 
is done when L&TT is started up, and only scan the single device on which you wanted to run tests. This helped to 
eliminate problems in large SAN environments related to the large amount of time it took to complete the initial scan, and 
the disruption to scanned devices. 

With the release of L&TT v3.5, there are two major changes that greatly improve the usability and functionality of the 
scanning operation via the new Scan Mode Selection feature. 

 The Skip-Scan function is now incorporated into the user interface, making it easier to 
use. Additionally, the functionality is changed so that multiple devices can now be 
selected, eliminating the previous restriction of a single device only. 

 L&TT now always saves the scan results and allows the user to utilize a saved scan 
rather than having to perform a hardware scan each time. This not only improves 
performance, but also the usability of the Skip-Scan function because the user can now 
select the hardware address of the device in question, rather than having to memorize it 
and enter it manually. 
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Using the Scan Mode Selection feature 

Windows 

Beginning with L&TT v3.5, when L&TT is first started, the initial splash screen is presented prior to any bus scanning 
activity taking place. Therefore, it launches quickly and does not interfere with any devices on your system. The initial 
screen now lets you choose whether to do a hardware scan, or use a previously saved/manual scan, in addition to giving 
you the opportunity to select I/O mode as it has in the past. 

 

The first time you run L&TT, it must perform a full hardware scan (Hardware Scan option), and the Saved/Manual Scan 
option is disabled. This is because L&TT has no previous scan result information to access. However, now the results of 
the full hardware scan are automatically saved, so the next time L&TT is started, the Saved/Manual Scan option is 
available.  

When L&TT performs its initial device scan, it identifies all the devices connected to the computer either directly, or 
through a SAN. In large SAN environments, this scan can take a long time. After the initial scan is complete and saved, 
future full system hardware scans become unnecessary in most cases. Exceptions are as follows and apply to Windows 
in NT Miniport I/O mode of operation: 

 After the hardware configuration has been changed 

 After power cycling more than one of the tape drives on the system 

 After updating firmware in more than one of the tape drives on the system 
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You must perform a hardware scan after any of these actions have taken place. To perform a hardware scan, exit and 
restart L&TT. On the splash screen, select the "hardware scan" option rather than "saved scan." If you do not do this, the 
Windows operating system might get out of sync with the L&TT saved scan because Windows device rediscovery assigns 
new logical device names to the devices.  

Also, if  you power cycle or update firmware in a device while using a saved scan, the device may not be accessible until it 
is rediscovered by Windows. If you are running L&TT v3.5 (or later) and select the device before it is rediscovered, L&TT 
generates an error. Previous to v3.5, the device would not be identified in the scan, but because the scan is now saved, 
the device is displayed. After Windows has rediscovered the device, the device can be selected without causing an error. 

If you are running in saved scan mode and want to rescan the bus for devices, clicking the Rescan button on the Scan 
tab of L&TT does not initiate a hardware scan. You must exit and restart L&TT, and then choose the hardware scan 
option on the splash screen to execute a hardware scan. 

To enable the Saved/Manual Scan option on Windows: 

1. Select the Saved/Manual Scan option, and then click Continue. 

The Saved/Manual Scan window opens.  

 

The left panel of the Saved/Manual Scan screen displays the devices that were detected in the initial hardware 
scan (or the last saved scan). The right panel of the screen displays any selected devices. If this is the first time 
through the process, only the device type headings appear in the right panel because no devices have been 
selected at this point. 

2. If the hardware configuration has changed since the last saved scan, click the Scan 
Hardware Now button to rescan the system for new devices. If you want to manually add 
a device to the list in order to avoid executing a full system hardware scan, click the 
Enter Address Manually button. 

3. To select only the device(s) you want to scan, there are several buttons provided for 
selection and removal of devices from the selected devices list: 
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 Select All: Click to put all scanned devices from the Saved Scan list (left 
panel) into the Selected Devices list (right panel) (see example). 

 

 Remove All: Click to remove all devices from the Selected Devices list. 
 Select: Click after highlighting a device in the Saved Scan list to move it to the 

Selected Devices list. 
 Remove: Click after highlighting a device in the Selected Devices list to 

remove it. 
 Continue: Click to perform the scan of the selected devices, and proceed to 

the main L&TT window. 
 Cancel: Click to close the dialog box and revert back to the previous window 

without making any changes. 

Note: After at least one device is saved in the selected devices panel list, the Saved/Manual Scan option is available in 
the splash screen; if selected, L&TT only scans devices in that list. 

 

HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

For instructions on how to launch L&TT, see Getting started on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX.  

Beginning with L&TT v3.5, after you have launched L&TT, the Scan Mode Selection screen is displayed.  
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The first time you run L&TT, it must perform a full hardware scan (Hardware Scan option); the Saved/Manual Scan option 
is disabled. This is because L&TT has no previous scan result information to access. Commands available from this initial 
screen are as follows: 

 Exit: Exits the L&TT application. 

 Clear: Deselects the current scan mode. 

 Continue: Starts the specified scan mode (enter this command to execute the initial full 
hardware scan in the above screen). 

 Select: Selects the scan mode (Saved/Manual Scan mode will not be available until after 
an initial full hardware scan has successfully completed). 

Beginning with L&TT v3.5 the results of the full hardware scan are automatically saved, so the next time L&TT is 
launched, the Saved/Manual Scan option is available.  

When L&TT performs its initial device scan, it identifies all the devices connected to the computer either directly, or 
through a SAN. After the initial scan is complete and saved, future full system hardware scans become unnecessary, 
unless the configuration is changed.  

To enable the Saved/Manual Scan option on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. In the Scan Mode Selection screen, select the Saved/Manual Scan option, and then enter 
Continue at the command prompt. 



L&TT Support Guide (End User Edition) 

50 

 

The Saved/Manual Scan screen is displayed. This screen enables you to select the devices that you want L&TT 
to scan and identify. This can save a lot of time in a large SAN environment if you want to test only one or two 
devices. Any devices that you don’t select will not be scanned, and they will not be displayed in the device list.  

 

2. The following commands are available from the Saved/Manual Scan screen: 

 Select: Scans the selected device(s). 
 SelectAll: Scans all devices. 
 Clear: Deselects the selected device(s) so they will not be scanned. 
 UnselectAll: Clears all devices. No devices will be scanned. 
 EnterHWAddrManual: Lets you manually enter the hardware address of a 

device to be scanned. 
 Hardwarescan: Performs a full hardware scan. Use this option to update the 

list of available devices on the Saved/Manual Scan screen. 
 Continue: Starts the indicated scan and proceeds to the Main screen. 
 Up: Exits the current command level. 
 Exit: Exits the L&TT application.  

3. To continue navigating through subsequent screens to select devices for testing, and so 
on see To Navigate L&TT on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX and 
begin at step 3. 



Getting Started (Setup and Problems) 

51 

 

Using the Skip-Scan feature 

Skip-Scan is a feature that was added with L&TT v3.3. 

When the Skip-Scan feature is enabled, L&TT scans only for the device you specify. This is a useful feature when 
troubleshooting a device that is part of a SAN installation because it saves time and hangs or timeouts related to 
attempting to scan every device in the SAN. 

Beginning with L&TT v3.5, the Skip-Scan functionality was enhanced with an improved user interface and a new initial 
splash screen that gives you an opportunity not to scan the hardware configuration when L&TT is first started. See Using 
L&TT in SAN environments for more details on the new functionality introduced with v3.5. 

To use the Skip-Scan feature on Windows: 

1. Click Start > Run, and then enter the following into the Run dialog box: 

C:\Program Files\HP StorageWorks Library and Tape Tools\HP_LTT.exe  -o skipscan 

The Skip-Scan dialog box is displayed when L&TT opens. 

 

2. Enter the hardware address of the device you want to scan.  

 For NT Miniport I/O mode, the path is in the form <Port Number>/<Bus 
Number>.<Device Target ID>.<Device LUN> 

 For ASPI I/O mode, the path is in the form <Bus Number>.<Device Target 
ID>.<Device LUN> 

To use the Skip-Scan feature on HP-UX, Linux, NetWare, or Tru64 UNIX: 

1. Execute the following commands to launch L&TT with the Skip-Scan feature enabled: 

 For HP-UX, Tru64 UNIX, and Linux – Log on as root and execute the 
following commands: 

cd  /opt/ltt 

./hp_ltt -o skipscan 

 For Novell NetWare – Execute the following command from the server console: 

hp_ltt\hp_ltt -o skipscan 

2. At the prompt, enter the hardware address of the device  you want to scan. 
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Problems 

Device access issues (RSM on Windows, etc.) 

Tape devices and tape libraries require exclusive access on many operating systems to avoid interference between 
multiple processes accessing the same device. While there are differences between operating systems regarding how 
services and applications run, how they are monitored, and which error messages are displayed by L&TT when a conflict 
is detected, the basic issue remains the same: devices may show as inaccessible in L&TT if they are still claimed by 
another process.  

As a result, you cannot run L&TT and a backup application at the same time. If a backup application is still running, L&TT 
is unable to gain access to the tape drives, and functionality in L&TT is restricted. Similarly, if L&TT is running and a 
backup application tries to execute a scheduled job, the job may fail because it cannot access the drive. It should be 
noted that "backup applications" refers to service processes, drivers, or typical backup software applications. The 
Windows Removable Storage Management service (RSM) is an example of a process that blocks access to tape libraries 
and drives; it must be disabled or shut down before using L&TT. The L&TT splash screen contains a reminder of this. 
Click here for more information on RSM including how to disable and re-enable it, and so on.  

On large SANs, it is often impossible to entirely close all software applications while trying to run L&TT on a single drive. 
In these situations, use the SAN awareness features to bypass conflicts on all other devices, and focus on a single 
robotics controller or tape drive. However, even in this scenario, this single device must be released from control of any 
other software via appropriate means. 

On the Windows platform, there are two I/O modes available: NT Miniport I/O mode and ASPI I/O mode. The ASPI I/O 
mode has the ability to circumvent these exclusivity restrictions because it does not honor the security system built into 
the server variants of Windows, related to mutual exclusivity. This is also the reason that Microsoft views ASPI as a 
deprecated I/O model that should only be used when necessary. If you use ASPI to circumvent the exclusive access 
restriction, take extreme care to understand any interference that may occur, and interpret results accordingly. 



Getting Started (Setup and Problems) 

53 

Device performance issues 

 Poor performance with HP DLT VS80 and CA Brightstor v11 on Windows  

If backups are very slow and the hardware and media is believed to be ok, try the following to improve backup 
performance: 

 Stop the "CA Brightstor Tape Engine" service and locate the following registry 
folder using Regedt32.exe: 

HKLM/Software/Computer Associates/Brightstor ARCserve 
Backup/Base/TapeEngine/DEVICE#/ 

 Look at the Info value for the device# that corresponds with your DLT drive, then 
ADD DWORD value 

data type=Reg_Dword 

valuename=DefaultBlockFactor 

data=7, HEX 

 Restart the "CA Brightstor Tape Engine" service. File backup should now be 
much faster. 

 Poor performance on Windows 2003 Server systems with EBS installations 

Many of the ISV Backup Applications supported by HP request or require that the RSM service be disabled. 
When the Windows 2003 server is rebooted, even though RSM is disabled, it continues to initiate the Test Unit 
Ready (TUR) SCSI command indefinitely on all connected removable devices. This can cause issues with 
performance in an environment with many shared tape devices. Refer to Microsoft Knowledge Base Article 
842411 for instructions on how to work around this problem. 
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Firmware Functions 

About firmware functions 
If a newer firmware file than what you are currently running is available for one or more of your products, consider 
downloading and installing it. Updating to the latest firmware revision ensures that you have all the latest fixes and 
enhancements that are available for your device(s). If you are having problems with your device(s) currently, updating to 
the latest firmware may solve the problem. 

NOTE: For ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, use of L&TT to update 
firmware is not supported. Unless otherwise instructed by HP support personnel, firmware update operations for these 
products must be performed using the Command View ESL GUI (for libraries running Interface Manager firmware v1.4 or 
later), or CLI (for libraries running Interface Manager firmware older than v1.4) as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide.  If standalone L&TT is used to update firmware on a managed 
library, the management station is not aware of the firmware update and reports a firmware mismatch.  In addition, if the 
library is partitioned when the firmware update is attempted with standalone L&TT, it produces an invalid command error. 

If you would like to verify that you have the latest firmware revision for your product, or review release notes for a 
particular revision of firmware prior to making a decision to update, see Accessing firmware revision and release note 
information.  
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Accessing firmware revision and release note information 
Verify that you have the latest firmware revision or learn about the changes between your current revision and the latest 
revision, using the L&TT application. 

To Access firmware revision and release note information from the L&TT application (Windows): 

1. In the L&TT main screen, click File > Get Files From Web, or click the Firmware button 
on the menu bar, select the Local Firmware Files tab, and then click Get Firmware 
From Web. 

The Get Files From Web window opens. 

 

2. To view the latest firmware revisions for devices on your system, or for all devices, click 
the Firmware tab (if not already displayed), and then click the appropriate radio button.  

3. To view release note information, click the product ID of the firmware file whose 
information you want to view, and then click the Details button. If release notes are 
available, they are displayed in the File Details window. 
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To access firmware revision and release note information from the L&TT application (HP-UX and Linux): 

Note: The download function is not supported for NetWare, OpenVMS, or Tru64 UNIX; therefore, accessing firmware 
revision and release note information from the L&TT application is not supported.  

1. In the L&TT main screen, enter download. Note that in the example screen, only a 
library/autoloader device is configured. Your screen may list other devices and drives. 
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A required file from the HP ftp site is downloaded and the Download Tool screen opens. The status area at the 
bottom of the screen displays the progress of the download. 

 

2. In the Download Tool area, enter 5 at the command prompt. 

The Selector Screen opens, displaying the various firmware files. Review the list to note the latest firmware 
revision for your product. 
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3. To review release note information, enter the number of the file whose release note 
information you want to view. Use the ^U or ^D commands to page up or down through 
the screens to find the desired product and firmware file. Not all firmware files have 
release note information available. 
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Downloading/Updating 

Downloading/updating firmware files on Windows 

Typical firmware file download times range from less than 1 minute to 2 or 3 minutes. Upload or installation times to load 
the new firmware into the drive are typically less than 5 minutes. 

This section covers downloading, and then updating device firmware electronically from firmware files. This is the 
preferred method. Device firmware can also be updated via use of a Firmware Update tape (FUP tape). Click here for 
information and guidelines on using firmware update tapes. 

NOTE: For ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, use of L&TT to update 
firmware is not supported. Unless otherwise instructed by HP support personnel, firmware update operations for these 
products must be performed using the Command View ESL GUI (for libraries running Interface Manager firmware v1.4 or 
later), or CLI (for libraries running Interface Manager firmware older than v1.4) as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide.  If standalone L&TT is used to update firmware on a managed 
library, the management station is not aware of the firmware update and reports a firmware mismatch.  In addition, if the 
library is partitioned when the firmware update is attempted with standalone L&TT, it produces an invalid command error. 

 

 Downloading firmware files 

HP recommends that you use the Get Files From Web function to download firmware files under Windows. This is the 
simplest method, and it ensures that you only download files for devices you have on your system. You can also use the 
Download Files From External Web procedure, but you must ensure that you choose the correct product or you will 
download the wrong firmware file. In either case, L&TT checks to ensure that each product will be updated with the 
correct firmware update package.  

To get files from web using L&TT (Windows): 

1. In the L&TT main screen, click File > Get Files From Web or click the Firmware button 
on the menu bar, click the Local Firmware Files tab, and then click Get Firmware From 
Web (show me).  
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A status window displays the supported storage products on your system related to the latest available firmware 
revisions. If new firmware files are available, the firmware tab will also include the "(New Files Available)" notation 
on the tab. If no new firmware files are available, only the word "Firmware" is displayed on the tab." 

 

Note: In the above example screen capture (taken March 31, 2004), the VS 40/80 drive is already up-to-date, 
while the DLT 8000 is outdated. The updated firmware file for the DLT 8000 has been automatically selected as 
indicated by the checkbox, and the Selected for download status. To download this file to the local firmware 
directory, click the Download button. After the download completes successfully, the status changes to Local 
Copy Available.  

To download firmware files from external Web (Windows): 

1. Go to www.hp.com/support, choose your region, and then select storage for the product 
category. 

2. Select your product family, and then your particular product. 

3. In the I would like to box, click download drivers and software. 

4. Select your product and operating system, and then click the download button in the 
firmware section. The download file may be a single file (standalone drives) or a self-
extracting bundle that includes both automation and standalone drive firmware. 

5. Download the file or files to the firmware directory. If it’s a self-extracting bundle, extract 
the contents to the firmware directory.  
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Updating device firmware 

To update device firmware (Windows): 

1. Download the firmware file (if you haven't already). 

2. After the file has been downloaded, click the firmware button on the menu bar (if not 
already in the firmware window). 

3. Click the Update Firmware tab. 

The Update Firmware window opens.  

 

Note: In the above example screen capture, the current version is v086, the new version is v088, and the drive is 
ready to be updated with the new firmware. The v088 firmware file is already selected for update as indicated in 
the File Selection portion of the window. With several products, after the firmware file is selected, a message is 
displayed to inform you of certain requirements (such as important prerequisites for updating with the new 
firmware), or noteworthy functional changes (such as a new LED sequence). Be sure to read any such messages 
and take any appropriate actions. Click the Start Update button to initiate the firmware update process.  

 

CAUTION : A filing cabinet is a good analogy for a database structure. The file room is where all the 
file cabinets are stored; this to be the database. The file cabinets each hold specifically organized 
information (for example, one cabinet may store employee information, another may house 
equipment information); these file cabinets are the tables. Within each file cabinet, there are file 
folders, each containing very specific parcels of information (for example, employee resumes or 
equipment receipts); these are the fields. Put it all together and you have the basic structure for a 
database. 
  Ensure that no other programs attempt to access the device while the firmware is being updated. 
Do not interrupt the firmware update; the device may not operate and will likely require physical 
repair. 

4. When the firmware update is complete, the Firmware Update window opens, explaining what 
may happen related to the Windows plug-and-play implementation. It also explains how 
to make the drive visible to L&TT and the Windows operating system, so that it will 
operate properly. 
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5. If the device is not visible to L&TT and/or the operating system after you have 
successfully updated the firmware, follow the process indicated in the Firmware Update 
window (Step 4) to ensure the updated device is fully visible to and usable by the system. 
Please make sure you follow this entire procedure before calling HP customer support. If 
you have followed the procedure, and your device is still not accessible, call HP customer 
support for assistance. 
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Downloading/updating firmware files on HP-UX, Linux, NetWare, OpenVMS, 
or Tru64 UNIX 

Typical firmware file download times range from less than 1 minute to 2 or 3 minutes. Upload or installation times to load 
the new firmware into the drive are typically less than 5 minutes. 

This section covers downloading, and then updating device firmware electronically from firmware files. This is the 
preferred method. Device firmware can also be updated via use of a Firmware Update tape (FUP tape). Click here for 
information and guidelines on using firmware update tapes. 

NOTE: For ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, use of L&TT to update 
firmware is not supported. Unless otherwise instructed by HP support personnel, firmware update operations for these 
products must be performed using the Command View ESL GUI (for libraries running Interface Manager firmware v1.4 or 
later), or CLI (for libraries running Interface Manager firmware older than v1.4) as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide.  If standalone L&TT is used to update firmware on a managed 
library, the management station is not aware of the firmware update and reports a firmware mismatch.  In addition, if the 
library is partitioned when the firmware update is attempted with standalone L&TT, it produces an invalid command error. 

NOTE: The screen captures that appear in this section were taken on a Linux system, but apply to HP-UX, NetWare, 
OpenVMS, and Tru64 UNIX, unless otherwise specified. Note that the screen captures are examples only; the content of 
user windows varies. 

 

Downloading firmware files 

HP recommends that you follow the process outlined in the To download firmware files from web using L&TT section to 
download firmware files for the various non-Windows platforms that support this feature. This ensures that you only 
download files for devices you have on your system. You can also use the procedure outlined in the To download files 
from external web section, but you must ensure that you choose the correct product. In either case, L&TT checks to 
ensure that each product will be updated with the correct firmware update package. 

Note: Downloading firmware files from the Web using the L&TT application is not supported with NetWare, OpenVMS, or 
Tru64 UNIX. 

To download firmware files from Web using L&TT (HP-UX and Linux): 

1. In the L&TT main screen, enter download. Note that in the example screen, there is only a 
library/autoloader device configured. Your screen may list other devices and drives. 
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A required file from the HP ftp site is downloaded and the Download Tool screen opens. The status area at the 
bottom of the screen displays the progress of the download. 

 

2. To download the latest firmware files for devices currently configured on the system, 
enter 1 at the command prompt. 

The Selector screen opens, displaying the product(s) and the latest firmware file available for that product.  
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Note: In this example, there is only one supported device configured on the system, so only one item is 
displayed. The firmware file shown is the latest available revision for that device. If there had been other 
supported devices configured, they would have appeared in this screen with a number associated with each of 
them. 

3. To download the latest firmware file, enter the number of the file for the device you are 
going to update. In this particular example you would enter the number 1 as that is the 
only choice available.  

To download all the firmware files for devices present in the system (HP-UX and Linux): 

1. In the Download Tool screen, enter 2 at the command prompt. 

The Selector screen opens, displaying the device(s) and all of the firmware files available for each device. 
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Note: In this example, there is a single supported device configured, and there are a total of two firmware files 
available for that device. 

2. To download the desired firmware file, enter the number of the file you want to download. 
In this particular example you would enter the number 1 if you want the older 
U709/OEM9 file or 2 if you want the latest U812/OEM9 file. 

To download the latest firmware files for other supported devices (HP-UX and Linux): 

1. In the Download Tool screen, enter 3 at the command prompt. 

The Selector screen opens, displaying all the supported device(s) and latest firmware files available for each 
device. 
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2. To download the firmware file, enter the number of the file you want to download. Note 
that you can use the ^U or ^D commands to page up or down through the screens to find 
the desired product and firmware file. 

To download all the firmware files for other supported devices (HP-UX and Linux): 

1. In the Download Tool screen, enter 4 at the command prompt. 

The Selector screen opens, displaying all the supported device(s) and firmware files available for each device. 

 

2. To download the firmware file, enter the number of the file you want to download. Note 
that you can use the ^U or ^D commands to page up or down through the screens to find 
the desired product and firmware file. 

To get release note information about a firmware file (HP-UX and Linux): 

1. In the Download Tool screen, enter 5 at the command prompt. 

The Selector Screen opens, displaying the various firmware files. 
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2. Enter the number of the file whose release note information you want to view. Note that 
you can use the ^U or ^D commands to page up or down through the screens to find the 
desired product and firmware file. Note also that not all firmware files will have release 
note information available. 

To download firmware files from external Web (HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX): 

1. Go to www.hp.com/support, choose your region, and then select storage for the product 
category. 

2. Select your product family, and then your particular product. 

3. In the I would like to box, click download drivers and software. 

4. Select your product and operating system, and then click the download button in the 
firmware section. The download file may be a single file (standalone drives) or a self-
extracting bundle that includes both automation and standalone drive firmware. 

5. Download the file or files to the firmware directory. If it is a self-extracting bundle, extract 
the contents to the firmware directory.  

 

Updating firmware files 

To update device firmware (HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX): 

1. In the L&TT main screen, enter the number corresponding to the device to be updated, 
and then press Enter. 

The Drive Information screen opens. 
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2. Enter firmware for the command. 

The Firmware Update screen opens. Devices available for update are listed in this screen.  

 

3. Enter the corresponding number of the device you want to update, and then press Enter 
to mark the device "selected.” If multiple devices are available and you want to select 
them for update as well, repeat this process for each device you want to update. 
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CAUTION : A filing cabinet is a good analogy for a database structure. The file room is where all the 
file cabinets are stored; this to be the database. The file cabinets each hold specifically organized 
information (for example, one cabinet may store employee information, another may house 
equipment information); these file cabinets are the tables. Within each file cabinet, there are file 
folders, each containing very specific parcels of information (for example, employee resumes or 
equipment receipts); these are the fields. Put it all together and you have the basic structure for a 
database. 
  Ensure that no other programs attempt to access the device while the firmware is being updated. 
Do not interrupt the firmware update as the device may not operate and will likely require physical 
repair. 

4. After selecting all the devices you want to update, enter start to begin the update 
process. 

While the firmware update is in process, the Firmware Update screen displays the status ("pending" in this 
example) and the progress (image 36 of 71 in this example) of the update; the progress is displayed in the bottom 
margin of the window.  

 

5. Entering a blank command (press Enter) displays the available commands, related to the 
firmware update function as shown in the following screen.  
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 Note: Entering options displays the current options, but you will not be able to change anything without the 
correct password. (Passwords are available only by contacting HP support, and should only be used under the 
direction of HP support personnel.)  
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Using a firmware update (FUP) tape 

The preferred method for updating drive firmware is by using the L&TT application. Firmware can be updated on both 
Windows and non-Windows platforms. However, there are some cases where L&TT is not available, or otherwise cannot 
be used (for example, with an unsupported operating system). In these cases, a firmware update (FUP) tape can be 
created and used for the purpose of updating drive firmware. In most cases, FUP tapes can be created by HP and 
supplied to end users, or be created by the end users themselves.   

When using L&TT to update firmware, there are protections in place to ensure that only the correct firmware is 
downloaded to the drive. There is no such protection mechanism with a FUP tape, so care must be taken to use the FUP 
tape only with the drive it is intended for. The tape will only update firmware if inserted into the correct hardware, but it 
could change a drive personality in some cases. For example, a FUP tape will overwrite OEM drive firmware if inserted 
into an OEM drive rather than a drive with HP personality.  

Performing the update 

The procedure for using a FUP tape varies depending on the drive type, and in some cases, whether or not the drive is in 
an autoloader or library. Click the appropriate drive type below to get the details associated with using a FUP tape for that 
drive. 

SDLT 

Standalone SDLT Drives 
There is no hard coded limit as to how many times a given SDLT FUP tape can be used to update the firmware in a 
particular SDLT drive type. To update the firmware in an SDLT drive using a FUP tape, you first have to put the drive in 
“FUP tape mode.” This is accomplished as follows: 

1. Unload any tape currently in the SDLT drive. 

2. With no tape in the drive, push and hold the eject button. After approximately five 
seconds, the left LED begins to flash. 

3. Release the eject button, and then push it again. The middle LED will also start flashing.  

4. Release the eject button. The drive is now ready to accept the FUP tape. 

5. Insert the FUP tape into the drive. It does not matter if the tape is write protected or write 
enabled. 

Caution: Do not power cycle or reset the drive. Make sure that no software attempts to access the drive during 
the firmware update process. Otherwise the drive may be damaged and need to be returned to HP for 
replacement.  

Note: If the drive is not put into FUP tape mode before you insert the FUP tape, it will not be recognized as a 
FUP tape. If the FUP tape is not write protected, you will be able to write over the FUP tape (but not append to 
it).  

6. When the firmware update process is complete, the drive ejects the FUP tape and 
performs a self test. 

7. Store, return, or dispose of the FUP tape as instructed by HP support personnel. See 
also Converting a firmware update (FUP) tape to a data tape. 

Libraries and Autoloaders 
Use of FUP tapes in STK libraries works just like it does for standalone drives, so see the description above for that 
information.  

For HP libraries: 



Firmware Functions 

73 

1. Ensure the target drive is empty. If a tape is in the target drive, use the front panel display 
to return the tape to a storage slot. 

2. Load the FUP tape into an empty slot 

3. From the main menu on the front panel, choose Administration, and  then Upgrade 
Firmware to access the Upgrade Drive Firmware menu. 

4. Use the [-] or [+] key to select the slot containing the FUP tape. Select [OK]. 

5. Monitor the front panel for status during the upgrade. The tape will return to the original 
slot when the procedure is complete. 

6. Remove the FUP tape from the library, and then power cycle the library. 

DLT VS80/DLT1 

Standalone DLT VS80/DLT1 Drives 
There is no hard-coded limit as to how many times a given DLT VS80/DLT1 FUP tape can be used to update the firmware 
in a particular DLT VS80/DLT1 drive type. To update the firmware in a DLT VS80/DLT1 drive using a FUP tape, you first 
have to put the drive in FUP tape mode. To do this: 

1. Unload any tape currently in the DLT VS80/DLT1 drive. 

2. With no tape in the drive, push and hold  the eject button. After approximately five 
seconds, the leftmost and rightmost LEDs light. 

3. Continue to hold the eject button depressed until all the LEDs go out. 

4. Immediately release the eject button. The middle LED will light. 

5. Push and release the eject button. All LEDs will start flashing. The drive is now ready to 
accept the FUP tape. 

6. Insert the FUP tape into the drive. It does not matter if the tape is write protected or write 
enabled. 

CAUTION: Do not power cycle or reset the drive. Make sure that no software attempts to access the drive 
during the firmware update process. Otherwise the drive may be damaged and need to be returned to HP for 
replacement.   

Note: If the drive is not put into FUP tape mode before you insert the FUP tape, it will not be recognized as a 
FUP tape. If the FUP tape is not write protected, you will be able to write over the FUP tape (but not append to 
it).  

7. When the firmware update process is complete, the drive ejects the FUP tape and 
performs a self test. 

8. Store, return, or dispose of the FUP tape as instructed by HP support personnel. See 
also Converting a firmware update (FUP) tape to a data tape. 

Libraries and Autoloaders 
Use of FUP tapes in STK libraries works just like it does for standalone drives, so see the description above for that 
information.  

For HP libraries: 

1. Make sure that the target drive is empty. If a tape is in the target drive, use the front panel 
display to return the tape to a storage slot. 
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2. Load the FUP tape into an empty slot. 

3. From the main menu on the front panel, choose Administration, and then Upgrade 
Firmware to access the Upgrade Drive Firmware menu. 

4. Use the [-] or [+] key to select the slot containing the FUP tape. Select [OK]. 

5. Monitor the front panel for status during the upgrade. The tape will return to the original 
slot when the procedure is complete. 

6. Remove the FUP tape from the library, and then power cycle the library. 

DLT 4000/7000/8000 

Standalone DLT 4000/7000/8000 drives 

There is no hard-coded limit as to how many times a given DLT 4000/7000/8000 FUP tape can be used to update the 
firmware in a particular DLT 4000/7000/8000 drive type. To update the firmware in a DLT 4000/7000/8000 drive using a 
FUP tape, you first have to put the drive in FUP tape mode. To do this: 

1. Unload any tape currently in the DLT 4000/7000/8000 drive, and then lower the operator 
handle. 

2. With no tape in the drive, push and hold the unload button. After approximately five 
seconds, the Write Protect LED will begin to flash. 

3. Release the unload button and immediately press it again. The Tape In Use LED will 
now also flash. 

4. Release the unload button. The drive is now ready to accept the FUP tape. 

5. Lift the operator handle, insert the FUP tape into the drive, and then lower the operator 
handle. It does not matter if the tape is write protected or write enabled. 

CAUTION: Do not power cycle or reset the drive. Make sure that no software attempts to access the drive 
during the firmware update process. Otherwise the drive may be damaged and need to be returned to HP for 
replacement.   

Note: If the drive is not put into FUP tape mode before you insert the FUP tape, it will not be recognized as a 
FUP tape. If the FUP tape is not write protected, you will be able to write over the FUP tape (but not append to 
it).  

6. When the firmware update process is complete, the drive ejects the FUP tape and 
performs a self test. Lift the operator handle and remove the FUP tape. 

7. Store, return, or dispose of the FUP tape as instructed by HP support personnel. See 
also Converting a firmware update (FUP) tape to a data tape. 

Libraries and Autoloaders 
Use of FUP tapes in STK libraries works just like it does for standalone drives, so see the description above for that 
information.  

For HP libraries: 

1. Make sure that the target drive is empty. If a tape is in the target drive, use the front panel 
display to return the tape to a storage slot. 

2. Load the FUP tape into an empty slot. 

3. From the main menu on the front panel, choose Administration, and then Upgrade 
Firmware to access the Upgrade Drive Firmware menu. 
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4. Use the [-] or [+] key to select the slot containing the FUP tape. Select [OK]. 

5. Monitor the front panel for status during the upgrade. The tape will return to the original 
slot when the procedure is complete. 

6. Remove the FUP tape from the library, and then power cycle the library. 

Ultrium 

Standalone Ultrium Drives 
There is no hard-coded limit as to how many times a given Ultrium FUP tape can be used to update the firmware in a 
particular Ultrium drive type. To update an Ultrium drive with a FUP tape, insert the tape into the Ultrium drive. It does not 
matter if the tape is write protected or write enabled. HP Ultrium drives automatically recognize a valid FUP tape when 
inserted and begin updating the firmware. When the firmware update process has completed, the tape is ejected, and the 
drive executes a self test. 

CAUTION: Do not power cycle or reset the drive. Make sure that no software attempts to access the drive during the 
firmware update process. Otherwise the drive may be damaged and need to be returned to HP for replacement.   

Note: Ultrium FUP tapes can be converted back to data tapes via the LTO Firmware to Data Tape Creator test. See that 
test description for details.  

Libraries and Autoloaders 
Use of FUP tapes in STK libraries works just like it does for standalone drives, so see the description above for that 
information.  

For HP libraries: 

1. Make sure that the target drive is empty. If a tape is in the target drive, use the front panel 
display to return the tape to a storage slot. 

2. Load the FUP tape into an empty slot. 

3. From the main menu on the front panel, choose Administration, and then Upgrade 
Firmware to access the Upgrade Drive Firmware menu. 

4. Use the [-] or [+] key to select the slot containing the FUP tape. Select [OK]. 

5. Monitor the front panel for status during the upgrade. The tape will return to the original 
slot when the procedure is complete. 

6. Remove the FUP tape from the library, and then power cycle the library. 

HP DDS/DAT 

Standalone DDS/DAT Drives 
DDS/DAT FUP tapes can typically be used up to 1000 times to update the firmware in a particular DDS drive type 
(depending on the limit used at the time of FUP tape creation). Drives that can be updated via an FUP tape are HP DDS4 
(C5683A) and HP DAT72 (C7438A). Updating drive firmware via FUP tape is not supported on other HP DDS/DAT drives.  

To update DDS/DAT drive firmware with a FUP tape, ensure that the tape is write enabled, and then insert it into the 
DDS/DAT drive. HP DDS/DAT drives automatically recognize a valid FUP tape when inserted, and begin updating the 
firmware. When the firmware update process has completed, the tape is ejected, and the drive executes a self test. 

CAUTION: Do not power cycle or reset the drive. Make sure that no software attempts to access the drive during the 
firmware update process. Otherwise the drive may be damaged and need to be returned to HP for replacement.   

Note: DDS/DAT FUP tapes cannot be converted back to data tapes. After a FUP tape is created, it can only be used as a 
FUP tape and cannot be written to again. 

Autoloaders 
Updating DDS/DAT autoloaders via FUP tape is not currently supported. 
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Compaq/Sony AIT & DDS 

Standalone DDS/DAT Drives 
There is no hard-coded limit as to how many times a given Compaq/Sony AIT/DDS FUP tape can be used to update the 
firmware in a particular drive type. To update AIT/DDS drive firmware with a FUP tape, ensure that the tape is write 
protected, and then insert it into the AIT/DDS drive. The drive automatically recognizes a valid FUP tape when inserted, 
and begins updating the firmware. When the firmware update process has completed, the tape is ejected, and the drive 
executes a self test. 

CAUTION: Do not power cycle or reset the drive. Make sure that no software attempts to access the drive during the 
firmware update process. Otherwise the drive may be damaged and need to be returned to HP for replacement.   

Note: AIT/DDS FUP tapes cannot be converted back to data tapes. After a FUP tape is created, it can only be used as a 
FUP tape and cannot be written to again. 

Autoloaders 
The process for updating drive/autoloader firmware via FUP tape is the same as documented above for standalone 
AIT/DDS drives. 

Converting a firmware update (FUP) tape to a data tape 

In many cases, FUP tapes can be converted back to a regular data tape. The method of doing this varies depending on 
the drive type.  

 DLT 4K/7K/8K, SDLT, and VS80/DLT1 tapes can be converted back to data tapes by 
making sure they are write-enabled, inserting them into a drive, and then writing to them. 

 LTO drives require the LTO Firmware to Data Tape Creator test to convert a FUP tape 
back to a data tape. 

 HP StorageWorks and Surestore DDS, AIT, and Compaq/Sony DDS drives cannot 
convert FUP tapes back to data tapes.  
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Available Test Functions 

L&TT Utility Functions 

L&TT Utility Functions 

Utility functions execute SCSI utility scripts (files with .scc extension) stored in the "scripts" directory. These scripts send 
various SCSI commands to the selected device, but they generally do not return any results. Utility functions are generally 
device-specific and intended only to remedy specific problems that may occur with a particular device. 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  Using a script improperly or when it is not required can cause harm, possibly rendering a device 
inoperable. Do not attempt to use these utility functions unless you are very familiar with SCSI operation, or 
unless you have been advised to do so by an HP technical support representative or a Device Analysis 
script.  

Note: The "ddswriterecal" script used to recalibrate HP DDS3 drives does not run on L&TT v3.5. Download and install 
L&TT v3.5 SR1 to correct the problem. 

 

Windows 

To use the utility function on Windows: 

1. Select Utilities > Run Script from the main menu. The Run Script window opens. 

2. In the "devices" section, click the check box next to the device on which you want to run 
the script. The device logical name is now assigned (show me). 
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3. Click Browse to select a script file to execute (show me). The utility scripts are located in 
the "scripts" directory and have an .scc extension. 
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4. Select a script, and then click Open to return to the Run Script window. 

5. Click Run Script. 

When the script is complete, relevant information is displayed in the script output and script execution log text 
boxes. 

 

 HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

To use the utility function on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. In the L&TT main screen, enter the number corresponding to the device you want to test 
(show me). 

 

The Device Information screen is displayed for that device. 
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2. Enter the runscript command. 

The Run Script screen is displayed. 

 

3. Enter 1 to specify the script path, and then enter the path, including the filename, of the 
script (show me). The utility scripts are located in the "scripts" directory and have an .scc 
extension. 
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4. Enter the start command to execute the selected script. The Start screen is displayed. 
When the script completes, you are requested to press any key to continue.  

5. Enter additional information if required by the script (none required in this case). 

6. Enter the review command to review the results of running the script. 

7.  Use the Up or Exit commands to exit the tool when the test is complete.  
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Diagnostic Tests 

About diagnostic tests 

Note:  L&TT tests are constantly being updated to give improved test coverage and problem diagnosis. As new device 
issues are discovered, changes are made to the tests to properly diagnose those issues. Previous to L&TT v3.5 SR1, 
updates to some tests and test scripts were sometimes made available via the L&TT web site for download using the "get 
files from web" function. With the release of v3.5 SR1, test script updates are only available via a new release of L&TT or 
a hot fix distribution. In order to ensure you have the latest available test scripts, it is recommended that you keep your 
version of L&TT up to date, and download any hot fixes which are made available. 

Available tests 

Click any test below to view details about the test, including when to run the test, test duration, and so on. Not all tests are 
available for all products. For information on running the tests, click here for Windows and here for non-Windows.  

 Autoloader Exerciser test 

 Connectivity test 

 Data Compression test 

 Device Acceptance test 

 Device Assessment test 

 Device Analysis test 

 Device self test 

 DLT SRAM check (long) 

 DLT SRAM check (short) 

 ESL Vendor ID toggle 

 Firmware Tape Creator 

 Full Sweep test 

 Initialize Element Status Test 

 Library Exerciser test 

 LTO Cooling check 

 LTO Firmware to Data Tape Creator 

 Media Analysis test 

 Media Erase test 

 Media Validation test 

 Read SDLT Media IDs test 

 Read/Write Stress test 

 Read/Write test 
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 Restore Factory Settings test 

 Tape Edge Damage (TED) test (SDLT) 
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Windows 

Running diagnostic tests on Windows 

Downloading and updating scripts files is no longer supported by L&TT beginning with v3.5 SR1. When new scripts are 
available, they will be distributed in L&TT install bundles only as part of regular L&TT releases, service releases (such as 
v3.5 SR1), or hot fixes as necessary. 

To run a diagnostic test on Windows: 

1. After L&TT completes its device scan, select the device you want to test, and then click 
the test button.  

The Test window opens. 

 

2. Click the check box of the device you want to test, and then click the Test Group drop-
down arrow to display a list of the tests available for the selected device. 

3. Select a test to run. 

The test description is displayed in the description area. For more information on a specific test, see About 
Diagnostic tests, and then click the test for which you want more information.  

4. Some tests have certain option settings that can be viewed and/or revised: 

a. After you have selected a test, click the Options button to view optional settings for that test. If any 
test options are available for a given test, they are displayed in the Options dialog box when the 
Options button is clicked. Click here to see an example for the Read/Write test. 
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b. Double-click any setting you want to change. This puts the test into edit mode so you can enter a 
desired value. 

c. Click OK, and then click Start Test.  

Note: Only a few of the tests have configurable options.  
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HP-UX, Linux, NetWare, OpenVMS, and Tru64 UNIX 

Running diagnostic tests on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

Notes:  

 Downloading and updating scripts files is no longer supported by L&TT beginning with v3.5 SR1. When 
new scripts are available, they will be distributed in L&TT install bundles only as part of regular L&TT 
releases, service releases (such as v3.5 SR1), or hot fixes as necessary. 

 The screen captures that appear in this section were taken on a Linux system, but apply to HP-UX, 
NetWare, OpenVMS, and Tru64 UNIX, unless otherwise specified. Note that the screen captures are 
examples only; the content of user windows varies. 

To run a diagnostic test on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. In the L&TT main screen, enter the number corresponding to the device that you want to 
test. 

The Device Information screen opens. 

 

2. Enter test at the command prompt. 

The Test screen opens, displaying the currently selected test and the available devices to be tested. The 
currently selected device is indicated with an “X” in its checkbox. 



Available Test Functions 

87 

 

 To deselect one device and select another, enter the number of the device you 
want to deselect, and then enter the number of the device you want to select. You 
can deselect all devices by typing clear.  

 To view a list of available test function commands, enter a blank command (press Enter). 

 

 If you want to select a different test, enter picktest. 

The Selector screen opens, displaying the available tests for the selected device. Note that not all tests are 
available for any given device. Only tests available for the currently selected device are displayed. Type the 
number of the test you want to run. The Test screen reappears displaying the new test selection. 



L&TT Support Guide (End User Edition) 

88 

 

Note: For more information on the tests, see About Diagnostic tests. 

3. To review or revise test options for any tests that support them: 

a. Review steps 1 and 2 above if you need info on how to navigate to the test screen. 

b. After you have selected a test and are in the test screen, enter the testoptions command. Click here 
for an example of test options for the Read/Write test. If you want to revise a particular option, enter 
the number of that option and provide the updated information. This same process is applicable for 
any test that has selectable options. 
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4. To start the test, enter start. When the test completes, a dialog box opens, displaying the 
preliminary results of the test. Press any key to return to the Test screen.  

5. To view detailed test results, enter review at the command prompt. Use the detail 
command to determine the amount of detail to display. Available detail level arguments 
are: 

 1 – highlights only 
 2 – normal 
 3 – more details 
 4 – everything 
 5 – factory only (requires password) 

6. If necessary, use the ^U and ^D commands to scroll up and down through the test 
results.  

The Viewer screen shows an example of the output from running the acceptance test on an SDLT drive (note 
that in this case, the test failed).  
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Tests 

Autoloader Exerciser test 

Autoloader Exerciser test specifications 

Item Description 

Description Checks the mechanics of your DDS Autoloader. 

When to run When you want to verify that the mechanics of your DDS autoloader are working 
properly. 

Average duration ~10 minutes 

Other notes Test will not overwrite any data on the media. 

Available for DDS Autoloaders. 
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Connectivity Test 

Connectivity test specifications 

Item Description 

Description Writes data to the internal buffers in your product  to verify that the physical 
connection between your host and the storage device is operational; No media is 
required. 

When to run When there is a question about the integrity of the bus connection from the device to 
the host computer. 

Average duration <1 minute 

Other notes Test will not overwrite any data on the media, should there be any present in the 
drive. 

Available for AIT, DDS, DLT, LTO, MO, STK 9840 drives and MSL libraries. 
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Data Compression test 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

Data Compression test specifications 

Item Description 

Description Tests the hardware compression capability of your tape drive. You need a writable 
tape to complete this test.  A file is created on tape that is designed to have a 
compression ratio of approximately 2:1– anything less than 2:1 could mean that your 
hardware compression is disabled. Compression ratios are reported to the user at 
the conclusion of the test. If the test finds that hardware compression has been 
disabled by the host or by a switch configuration, it reports this to the user. 

When to run When you want to verify that data compression is working properly. 

Average duration <10 minutes 

Other notes Test will overwrite all data on the media. 

Available for All tape products (drive and automation) supported by L&TT. 
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Device Acceptance test 

Beginning with L&TT v3.5 SR1, the Device Acceptance Tests have been replaced with the  Device Assessment Tests. If 
you are using any diagnostic tools or documentation that recommends running the Acceptance test, you should run the 
Assessment test instead. 
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Device Assessment test 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

Device Assessment test specifications 

Item Description 

Description Note: In versions of L&TT prior to 3.5 SR1, this test was called the Device Acceptance 
test. 

Determines the overall pass/fail status of drive. If a drive fails, the drive should be 
replaced. If it passes, the problem is likely not drive hardware related. This test has a 
direct correlation to the repair center acceptance/validation tests. If it passes at the 
user site, it will pass at repair center, and can be captured as NTF and returned to 
spares stock for future shipment as a replacement drive. If this test passes, you 
should look elsewhere in the system for the problem solution. 

There are no supported options for this test, with the exception of the SDLT 
Assessment test, and the LTO Assessment test. If you want to test for tape edge 
damage on an SDLT 110/220 drive, enable the Media Test option (false by default). 
Tape edge damage has been shown to be caused by certain older SDLT 110/220 
drives. Click here for information on the use of this test option. For the LTO test, four 
options are available. Click here for information on the LTO/Ultrium Assessment test 
options. 

 Enable Device Analysis: TRUE by default 

 Enable SCSI Controller Test: TRUE by default 

 Enable Write/Read Test: TRUE by default 

 Ignore Cleaning Requests: FALSE by default 

If you enable this test, it will not run the standard Assessment test, but rather a 
specific test to analyze the tape by looking at data accumulated by the drive during 
writing. The objective of the test is to identify any tapes that may have edge damage. 
Beginning with L&TT v3.5, at the conclusion of the media test, L&TT may ask you to 
disable the Media Test option and rerun the Assessment test, dependent on the 
results of that test. This test option was formerly called Drive/media Interaction test.  

For more information on viewing and setting options, see Running diagnostic tests on 
Windows or Running diagnostic Tests on HP-UX, Linux, NetWare, OpenVMS, or 
Tru64 UNIX. 

If the test is being run on an autoloader and it is configured in "circular" or "stacker" 
mode (dependent on the particular autoloader), when an unload command is 
received from the host (such as is issued with the assessment test), the autoloader 
moves the next available cartridge into the drive. If the magazine is not loaded with 
data cartridges and cleaning cartridges in the correct order to meet the needs of the 
test, the test will fail. HP recommends using the single cartridge process when 
running the assessment test on an autoloader. 

To run the assessment test on an autoloader in single cartridge mode, start the test 
with a single data cartridge loaded in the magazine. 

Caution: The data cartridge is overwritten during the test. 

If the test requests a cleaning tape, eject the magazine and replace the data tape with 
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a valid cleaning tape. When the test asks again for a data tape, eject the magazine 
again and replace the cleaning tape with a data tape. Some autoloaders (DDS for 
example) request a cleaning tape at some point during the test, while others may not. 
The single cartridge process works effectively with any autoloader type. 

Click here for more details on the DLT, VS80 & SDLT Assessment test. 

 SCSI Interconnect test 

 Review event log entries (which were present prior to 
running the test) 

 Load the test tape 

 Quick write/read test 

 Soft unload/load test (DLT acceptance test only) 

 Minimum block size test 

 Diagnostic self test (built-in drive function) 

 read/write tests using various data patterns 

 bit error rate test 

 Review new event log entries added during the test 

 Unload the test tape 

Click here for more details on the Ultrium Assessment test. 

 Initial preparation 

 Review event log entries (which were present prior to 
running the test) 

 SCSI parity check (Ultrium 1 drives only) 

 Cartridge load 

 Quick read/write test 

 Cartridge unload 

 SCSI parity check 

 Review new event log entries added during the test 

Note: There was a problem with a log sorting routine in the Device Analysis scripts 
and Acceptance test in the L&TT v3.5 initial release. The misleading results could 
make drives appear faulty when they are good, and vice-versa. HP recommends that 
you install L&TT v3.5 SR1 or later to avoid this problem. 

Click here for more details on the DDS Assessment test. 

 Review event log entries (which were present prior to 
running the test) 

 Check life data in serial EEPROM and the fault log 
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 Load check 

 Perform a clean and write test 

 Unload check 

 MRS switch test 

 Read check 

 Review new event log entries added during the test 

Note: The DDS acceptance script was inadvertently excluded from the original L&TT 
v3.5 build. HP recommends that you install L&TT v3.5 SR1 or later to ensure that you 
have the DDS Drive Assessment test. 

When to run If the drive is suspected of failure, and you want to verify if the drive is good or bad. 
You should run the Media Test option if running an SDLT 220 drive and you suspect 
the drive may be damaging media, or if directed to do so by an HP tool or support 
person. 

Average duration 20 minutes duration for healthy drive with good tape (on average). Marginal drive (or 
drive with marginal tape) may take substantially longer. Average duration for the SDLT 
Acceptance test Media Test option is 15 minutes, but can take longer with a bad tape. 

Other notes Requires "good" tape that will be overwritten as part of test.  

Note: Running the Assessment test turns on compression in the drive, but does not 
restore the original drive configuration at the conclusion of the test. Therefore, if the 
customer configuration had compression disabled, after running the Assessment test, 
it will be enabled. If compression was enabled upon entering the Assessment test, it 
will still be enabled at the conclusion of the test. A future version of the Assessment 
test will note the drive configuration upon entering the test and will restore that 
configuration when exiting. 

Available for DLT 4000/7000/8000, VS80/DLT1, SDLT 220/320, Ultrium-1, Ultrium-2, DDS3, DDS4, 
and DAT72 (pre- and post-merger HP drives only). 
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Device Analysis test 

Device Analysis test specifications 

Item Description 

Description Test varies by device, but always includes a check for latest firmware (this requires a 
network connection). It also examines all device log data and reports any significant 
problems. On some devices, information from running device analysis is stored back 
onto the device to improve the diagnostic information provided. This test also provides 
summary information, suggestions to the cause of certain errors, and any remedial 
actions the user should take. 

When to run When you want to verify that basic functions of the device are operating properly and 
have not logged any critical errors, and to verify that firmware is up-to-date. 

Average duration <1 minute 

Other notes Test does not change the configuration of the drive or media. 

Available for All devices supported by L&TT. 
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Device self test 

Device self test specifications 

Item Description 

Description Performs the device internal power-on self-test to check the internal electronics of 
your product. 

When to run As a quick check of the integrity of the device. 

Average duration <1 minute 

Other notes Test will not overwrite any data on the media, should there be any present in the 
drive. 

Available for AIT, DDS, DLT, SDLT, VS80/DLT1, LTO autoloaders and drives. ESL, MSL, C7200, 
C7145, C5177, C1194F, C5151, C5173, C6280, SSL 1016 and STK libraries. STK 9840 
drives, MO drives & libraries, and A6356A fibre channel management card. 
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DLT SRAM check (long) 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

DLT SRAM check (long) specifications 

Item Description 

Description Performs a limited read/write test to determine if this drive exhibits symptoms of 
the FIFO (SRAM) CRC Errors. 

When to run When you suspect the drive may be responsible for CRC errors and want to run 
an extensive test to verify. 

Average duration Up to 1.5 hours 

Other notes You must have a write enabled tape in the drive and the drive must be ready 
before starting this test, or it will fail. Test will overwrite all data on the media. 

Available for DLT 8000. 
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DLT SRAM check (short) 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

DLT SRAM check (short) specifications 

Item Description 

Description Performs a limited read/write test to determine if this drive exhibits symptoms of the 
FIFO (SRAM) CRC Errors. 

When to run When you suspect the drive may be responsible for CRC errors and want to do a quick 
test to verify. 

Average duration ~20 minutes 

Other notes You must have a write enabled tape in the drive and the drive must be ready before 
starting this test, or it will fail. Test will overwrite all data on the media. 

Available for DLT 8000. 
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ESL Vendor ID toggle 

ESL Vendor ID toggle specifications 

Item Description 

Description Toggles the Vendor ID in an ESL library between "HP" and "Compaq." 

When to run If you want to change the vendor ID, which is required for some applications to work 
properly. 

Average duration <1 minute 

Other notes Test requires firmware version 3.40 or later. 

Available for ESL Libraries. 
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Firmware Tape Creator (FUP tape) 

Firmware Tape Creator specifications 

Item Description 

Description Lets you create a firmware update (FUP) tape on your drive. A FUP tape is a tape that 
is created when a firmware file for a particular drive type is written onto a blank tape. 
Click here for instructions on how to make a FUP tape for any drive for which this 
operation is supported (see “Available for” section).  

Steps to create a firmware update (FUP) tape using L&TT 

Note: FUP tapes for AIT drives and Compaq/Sony DDS drives cannot be created 
using L&TT and are therefore generally not available. It is possible to make FUP 
tapes for these products, but only by special request as it requires a special utility only 
available to the product lab.  

Note: The sample screen shots in this section refer to the DLT VS80 drive. What you 
will see with other drive types will be somewhat different, but similar in content and 
process flow.  

1. Navigate to the L&TT firmware folder (typically C:\Program 
Files\HP Library & Tape Tools\firmware) and locate the 
desired firmware file. Naming conventions for the firmware 
files will generally contain some form of the product name 
along with an indicator of the firmware revision. Some 
example filenames are: 

 C1537A_L111.frm 

 LTT_DLT8000_V088_CPQ-2.frm 

 LTT_Ultrium_2-SCSI_F78V_OEM18.frm 

Note: On Windows, the .frm extension may or may not be visible on your 
system depending on folder settings. See step 4 for more information. 

2. On Windows, if the desired firmware file is not available, use 
the L&TT get files from web for Windows feature to 
download the file from the web.  
 
If you are running HP-UX or Linux, use the L&TT get files 
from web for non-Windows feature. Download of firmware 
files is not supported using L&TT for NetWare, OpenVMS or 
Tru64 UNIX. For those operating systems, use the 
Download files from external web process.  

3. Make a copy of the selected firmware file and paste it into 
the same folder. 

4. Rename the copy of the firmware file per the following: 

 If filename extensions are currently visible in the 
firmware folder (you will see the .frm extension on 
the files), rename the firmware file to firmware.frm. 

 If filename extensions are not currently visible in the 
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firmware folder, rename the firmware file to 
firmware.  

Note: On Windows, the .frm extension is automatically included 
in the filename, but may be hidden from view depending on user 
preference settings. If filename extensions are not visible and you 
rename to firmware.frm, the .frm extension will still be 
automatically added so the filename you see is firmware.frm, but 
because the extension is hidden, the actual filename is 
firmware.frm.frm which will not work.  

Note: On Windows, you can verify that you have the correct firmware 
filename by configuring Windows to show all file extensions. Click here for 
instructions on how to do this. 

To configure Windows to display all file extensions: 

1. In the firmware folder (or any other Windows folder), 
select Tools > Folder Options. 

2. Click the View tab. 

3. Uncheck the Hide extensions for known file types 
option. 

4. Click OK. 

5. Start the L&TT application. 

6. Select the drive you will use to make the FUP tape(s): 

 For Windows, select the drive you will use to make 
the FUP tape(s) in the L&TT device list. 

 For HP-UX and Linux, enter the number 
corresponding to the device you want to test in the 
L&TT main screen. The Device Information screen 
is displayed. 

7. Access the L&TT Test screen: 

 For Windows, click Test. 

 For HP-UX and Linux, enter test at the command 
prompt. 

8. Select the Firmware Tape Creator test:. 

o For Windows, click the checkbox next to the drive 
shown in the Test Execution tab. This activates the 
Test Group dropdown menu. Select the Firmware 
Tape Creator test in the dropdown list. 

o For HP-UX and Linux, enter the picktest 
command. On the resulting screen, enter the 
number corresponding to the Firmware Tape 
Creator test. 
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9. Start the test: 

o For Windows, click Start Test. A dialog box reminds 
you to copy the desired firmware file to firmware.frm 
in the L&TT firmware directory if you haven’t already 
done so.  Click Yes to close this dialog box. 
 Another dialog might be displayed containing 
information about the compatibility of the FUP tape 
you are about to create. If so, click Yes to continue.  

Note: You can verify that you have the correct firmware filename 
by configuring Windows to show all file extensions. Click here for 
instructions on how to do this. See the notes in step 4 for more 
information.  

To configure Windows to display all file extensions: 

1. In the firmware folder (or any other 
Windows folder), select Tools > Folder 
Options. 

2. Click the View tab. 

3. Uncheck the Hide extensions for known 
file types option. 

4. Click OK. 

 For HP-UX and Linux, copy and rename the desired 
firmware file if you haven't already done so, then 
enter the start command to begin the test. 

1. Click the drive type you are using for instructions on finishing 
the FUP tape creation process. 

 SDLT, VS80/DLT1 

SDLT, VS80/DLT1 

1. Insert a write-enabled blank cartridge. 

 Standalone drives – Insert the tape 
and click Yes in the dialog box for 
Windows, or press Enter for HP-UX 
and Linux.. 

 HP and STK libraries – Use the 
library front panel to load the tape 
into the selected drive, and then 
click OK in the dialog box for 
Windows, or press Enter for HP-UX 
and Linux. 

2. Wait for the FUP tape creation process to 
complete. You will be notified when the FUP 
tape process is complete. When complete, 
the tape is ejected on standalone drives. 
The libraries require a front panel unload. 
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 LTO 

LTO 

1. Insert a write-enabled blank cartridge. 

 Standalone drives – Insert the tape 
and click Yes in the dialog box. 

 STK library drives – Open the 
library door, place the drive in 
standalone mode, and then insert 
the tape and click OK in the dialog 
box for Windows, or press Enter for 
HP-UX and Linux. 

 HP library drives – Use the library 
front panel to load the tape into the 
selected drive, and then click OK in 
the dialog box for Windows, or 
press Enter for HP-UX and Linux. 

2. Wait for the FUP tape creation process to 
complete. You will be informed when the 
process is complete. The tape will be 
ejected from standalone drives and drives in 
STK libraries. HP library drives will require a 
front panel unload. 

Note: The orange  “Tape error” and “Clean”  LEDs might be 
flashing at the end of this process. These can be safely ignored. 

 HP DDS/DAT 

HP DDS/DAT 

Note: DDS/DAT FUP tape creation is supported on HP DDS4 
and DAT72 drives only (C5683A & C7438A respectively). If using 
a DDS4 drive to create the tape, it must have at least rev C305 
firmware installed. FUP tape creation is not currently supported in 
DDS/DAT autoloaders. When making a FUP tape using L&TT, 
the tape will be made with an upgrade count of 1000, allowing for 
up to 1000 uses. 

1. Insert a write-enabled blank cartridge. 

 Standalone drives – Insert the tape 
and click Yes in the dialog box for 
Windows, or press Enter for HP-UX 
and Linux. 

 STK library drives – Open the 
library door, place the drive in 
standalone mode, and then insert 
the tape and click OK in the dialog 
box for Windows, or press Enter for 
HP-UX and Linux. 

 HP library drives – Use the library 
front panel to load the tape into the 
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selected drive, and then click OK in 
the dialog box for Windows, or 
press Enter for HP-UX and Linux. 

2. Wait for the FUP tape creation process to 
complete. You will be notified when the 
process is complete. The tape will be 
ejected from standalone drives and drives in 
STK libraries. HP library drives will require a 
front panel unload. 

 DLT 4K/7K/8K 

DLT 4K/7K/8K 

1.  Insert a write-enabled blank cartridge. 

 Standalone drives – Insert the tape 
and click Yes in the dialog box for 
Windows, or press Enter for HP-UX 
and Linux. 

 HP and STK libraries – Use the 
library front panel to load the tape 
into the selected drive, and then 
click OK in the dialog box for 
Windows, or press Enter for HP-UX 
and Linux. 

2. Wait for the FUP tape creation process to 
complete. You will be notified when the 
process is complete. When the “operate 
handle” LED lights,  you can safely remove 
the cartridge from standalone drives. The 
libraries will require a front panel unload. 

When to run 
When you need to create a firmware update (FUP) tape in order to update drive 
firmware.  

Average duration <2 minutes 

Other notes This utility expects to find a firmware image file (firmware.frm) in your firmware 
directory. You must create this file yourself by copying the file of the new firmware to 
firmware.frm. 

Available for DAT72 (C7438A), DDS4 (C5683A), DLT1, DLT 4000/7000/8000, LTO, SDLT, VS80.  
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Full Sweep test 

Full Sweep test specifications 

Item Description 

Description Performs a full sweep run-in test (either 100 or 1000 full sweeps). 

When to run If the results of running device analysis recommend that you run this test. This 
recommendation is based on reviewing library log data for certain critical errors, 
including those related to issues with the brush tracks. 

Average duration Up to 2.5 hours, depending on whether the long or short test is selected. 

Other notes Test will not overwrite any data on the media. Data from this test is logged into the 
library for future use by support personnel. 

Available for C7145 and C7200 libraries. 
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Initialize Element Status test 

Initialize Element Status test specifications 

Item Description 

Description Instructs the library to perform an inventory of all its elements. 

When to run To initialize the library in the event of cartridges being manually removed. 

Average duration Depending on the library, this test may take over 30 minutes. 

Other notes Test will not overwrite any data on the media. 

Available for All libraries supported by L&TT. 
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Library Exerciser test 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and can overwrite data on the media that is present in your product. 

Library Exerciser test specifications 

Item Description 

Description General purpose test of the library. It includes tests for moving cartridges within the 
library, loading cartridges into each one of the drives, and performing a short test of 
the drive while the cartridge is loaded. Test options include test time limits, slot and 
drive ranges, drive type selection, barcode checking, cartridge memory checking (in 
the case of LTO drives within the library), options for drive, and cartridge loading, 
and test coverage. 
 
For more information on viewing and setting options, see Running Diagnostic Tests 
on Windows or Running Diagnostic Tests on HP-UX, Linux, NetWare, OpenVMS, or 
Tru64 UNIX. 

Click here for available test options.  

 Test Time Limit – Specify the time limit in minutes. Enter 
"0" for no time limit (default setting). 

 Move Command Timeout – Specify the maximum time 
allotted, in seconds, for each move command before 
failure. The default is 600 seconds. 

 Active Slot Range –  Specify a range of slots to be tested. 
Enter a range of slot numbers separated with a dash (for 
example: 2-5), or enter "all" to specify all slots. The default 
is "all." 

 Drive Type Option –  Specify the type of drives to be 
tested (in libraries that have mixed drive types). Enter the 
type of drive (for example: LTO or DLT), or enter "all" to 
test all drive types. The default is "all." 

 Check Inventory Mode – Specify whether to perform an 
active inventory check at beginning of the test. The active 
inventory check can take a long time to perform. The 
default is "on." 

 Barcode Mode – Specify how barcodes are handled. 
Choose one of the following options 

o Show all – Shows all barcodes. 

o Show suspect– Shows only suspect barcodes (default). 

o Off – Does not show barcodes. 

o Slot-to-slot moves – Select one of the following options 
for the slot-to-slot test 
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o All – Moves all cartridges. 

o Random – Moves randomly selected cartridges (default). 

o Off – No cartridges are moved. 

 Random coverage – When slot-to-slot moves is set to 
"random," specify the percentage of units covered during 
random test. The default is 20%. 

 Drive load test – Specify whether or not to perform the 
drive load test. The default setting is "on." 

 Drive test option – If the drive load test is enabled, specify 
one of the following options 

o Off 

o Data loop back (default) 

o Read-only 

o Read/write 

 Cartridge load test – Specify one of the following options 
for the cartridge load test 

 Off (default) 

 Single drive 

 Multiple drives 

 All drives 

 CM integrity test – Specify whether to enable the CM 
integrity check option for LTO drives. The default setting is 
"on." 

When to run 
Whenever you want to verify the library is functioning properly. 

Average duration Highly dependent on the library being tested. 

Other notes Test can overwrite data on the media, depending on which test options are selected. 

Available for All libraries supported by L&TT. 
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 LTO Cooling check 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

LTO Cooling check specifications 

Item Description 

Description Monitors the internal temperature of your Ultrium drive and measures any 
temperature change after writing data. If the cooling is found to be inadequate, the 
test outputs recommendations. 

When to run When you want to verify the cooling requirements are being met for your Ultrium 
drive, particularly when installed in a server. 

Average duration 30 minutes 

Other notes Test will overwrite all data on the media. Data from this test is logged onto the drive 
in order to enable better user recommendations when the test is run again in the 
future. 

Available for LTO drives only. 
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LTO Firmware To Data Tape Creator 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

LTO Firmware To Data Tape Creator specifications 

Item Description 

Description Lets you to convert a previously created firmware upgrade tape back to a normal 
data tape on your Ultrium drive. 

When to run When you want to convert an Ultrium FUP tape back to a data tape. 

Average duration <2 minutes 

Other notes Test will overwrite all data on the media. 

Available for LTO drives only. 
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Media Analysis test 

Media Analysis test specifications 

Item Description 

Description Reads all valid data on the cartridge, verifies the readability and quality of the 
cartridge, and displays statistics about the data present on the cartridge. Also runs a 
self test and cleaning check, and prompts for cleaning cartridge if it deems 
necessary. 

When to run When you want to verify the integrity of the data on a particular piece of media, as 
read by a particular drive. 

Average duration < 5 minutes, using default test options. 

Other notes Test is non-destructive and will not overwrite any data on the media. Supports 
several test options to limit the data (size, time, and so on) or verify the entire tape 
(whole tape option). 

Available for LTO, DDS, AIT, DLT, SDLT, VS80/DLT1,  and STK 9840 drives. 
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Media Erase test 

Media Erase test specifications 

Item Description 

Description Converts an LTO or DDS data tape to a blank tape. There are three options for this 
test:  

 Quick erase: Removes the tape directory and writes EOD at 
the start of the tape but doesn't overwrite data on the 
remainder of the tape 

 Full erase: Erases the tape directory and also overwrites all 
data on the tape 

 Secure erase: Performs a full erase followed by a rewind. 
Repeats this cycle a total of 5 times. 

 

For more information on viewing and setting options, see Running Diagnostic Tests on 
Windows or Running Diagnostic Tests on HP-UX, Linux, NetWare, OpenVMS, or Tru64 
UNIX. 

When to run When you want to erase a tape that has been previously written. 

Average duration Quick erase takes about one minute. Full erase takes from 2 to 4 hours. Secure erase 
takes between 10 to 25 hours. 

Other notes Any data on tape will no longer be accessible after this test. See above description for 
more details. 

Available for DDS, Ultrium 1 and 2. 
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Media Validation test 

Media Validation test specifications 

Item Description 

Description Reads data on the tape cartridge or MO media in your storage device. No writes are 
performed so data contents of media are not changed in any way. Supports several 
test options for MO media (data limit options, starting block, block size, failure 
threshold, and so on), but none for tape. Also runs a self test and cleaning check, 
and prompts for cleaning cartridge if it deems necessary (tape only). 

When to run When you suspect a problem with your MO or other media. 

Average duration <5 minutes (using default test options) 

Other notes Test requires that a minimum amount of data is already written on the media, 
otherwise the test will fail. The amount of data varies depending on drive 
technologies and options (in the case of MO media). 

Available for AIT, DDS, DLT, SDLT, VS80/DLT1, LTO, and STK 9840 tape drives, and MO optical 
drives. 
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Read SDLT Media IDs test 

Test specifications 

Item Description 

Description Non-destructive test that loads each tape in the library into a drive and reads the 
media ID. At the conclusion of the test, click the Test Results tab to see the media 
ID, slot number, and barcode of each piece of media in the library. Normal usage for 
the Read SDLT Media IDs test is in conjunction with the SDLT Tape Edge Damage 
Test to identify the location of tapes in a library with tape edge damage (see also 
“Other notes” below).  

Note: The drives must be unloaded and the picker empty at the start of this test, or 
the test will fail with the message: “This test requires that all drives and the picker 
start out empty.” 

When to run After the SDLT Tape Edge Damage Test has identified that one or more tapes in 
the library need to be replaced. 

Average duration 45 to 50 seconds per tape (typical) 

Other notes This test assumes that the SDLT tapes have the proper barcode labels with “S” as 
the 7th character, that the SDLT drives have the latest firmware, and that the library 
is configured to show all barcode labels. Otherwise, the tapes may not be 
recognized with this test. 

Additionally, the library must be configured to automatically unload the tape when it 
is being moved from a drive. For MSL libraries, the Unload Mode option (under the 
Library Options screen) must be set to implicit. For ESL9000 libraries, the  Auto 
Drive Unload option (under operator/configure options) must be enabled. 

Available for ESL9000 and MSL libraries with SDLT 220 or SDLT 320 drives 
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Read/Write stress test (LTO) 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

Read/Write Stress test specifications 

Item Description 

Description Performs a self-test on the LTO drive, then an extensive write-read media test, and 
a load/unload test and cleaning tape check. Test options allow the user to select 
some options for amount of data written and read, whether a load/unload test is 
performed, and whether a cleaning tape check is performed. 

Click here for available test options. For more information on viewing and setting 
options, see Running diagnostic tests on Windows or Running diagnostic tests on 
HP-UX, Linux, NetWare, OpenVMS or Tru64 UNIX. 

 Enable 32GB Test (default is on)— when used together with the "Enable 
4GB Test" option, tests 36GB. This option can be disabled if a shorter 
duration test is desired. 

 Enable Load/Unload Test (default is: off)—used to test the load/unload 
function in standalone drives. This option must be "off" for automation 
products, or if you want to run unattended as the unload and load takes 
place towards the middle of the test .  

 Enable 4GB Test (default is on)—when used together with the "Enable 
32GB Test" option, tests 36GB. 

 Ignore Cleaning Requests (default is off)—if this option is "on," the test 
initially requests a cleaning, and it also requests one during the testing if 
it determines one is needed. When this option is "off," the drive never 
requests a cleaning during the entire test. 

 

 

When to run This is a very extensive test and would not normally be run except as directed by 
HP support engineers. 

Average duration >4 hours 

Other notes Test will overwrite all data on the media. 

Available for LTO drives only. 
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Read/Write test 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the media that is present in your product. 

 Read/Write test specifications 

Item Description 

Description Performs a self-test on the drive device, then a write-read media test to verify the 
ability to read and write data to and from the removable media in your storage 
device. This test also checks error rates and fails if allowable limits are exceeded. 
Test options allow the user to select the amount of data or length of test time, the 
amount of data transferred per command, and the data pattern. 

Click here for available test options. For more information on viewing and setting 
options, see Running diagnostic tests on Windows or Running diagnostic Tests on 
HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX.  

 Test time limit: Specifies the time limit in minutes. Enter 
"0" for no time limit. 

 Enable phase 2 and 3: Enables more extensive read/write 
sequence. Note that this will impact the length of time it 
takes to complete the test. 

 Data limit type: Specifies one of the following options to 
limit the amount of data written/read in each phase: 

o Time: Limits the amount of data tested based on the time specified in 
"data time limit." 

o Size: Limits the amount of data tested based on the size specified in 
"data size limit." 

o Whole tape: Limits the amount of data tested based on the size of the 
tape. 

 Amount of data written/read in each phase (MB): 
Specifies the size limit in megabytes of data to be 
written/read in each phase. 

 Time allowed for each data test phase (mins): Specifies 
the time limit, in minutes, for each phase of the test. 

 Block size for read/write (KB): Specifies the block size, 
in kilobytes, to be used in the test. 

 Max data transfer limit per command (KB): Specifies 
the maximum data transfer limit, in kilobytes, per 
command. 

 Block transfer type: Specifies whether to use a fixed or 
variable block length. 

 Data pattern type: Indicates the type of data pattern used 
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in the test. Specify one of the following data pattern types: 

o Pattern file: Uses a preset pattern. 

o Random: Generates random patterns. 

o User defined: Uses a user-defined string. 

 User-defined data pattern (string): Specifies a string 
value to use as a data pattern if the "data pattern type" is 
set to "user defined." 

When to run 
To verify the integrity of a particular piece of media, as written and read by a 
particular drive, and to verify the ability of the drive to read and write data 
independent of the storage application. 

Average duration <10 minutes, using default test options 

Other notes Test will overwrite all data on the media. 

Available for All devices supported by L&TT. 
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Restore Factory Default Settings test 

Restore Factory Default Settings test specifications 

Item Description 

Description Checks current configuration parameters of an MO drive and identifies any that differ 
from factory defaults. If any differences are detected, the test can reset to factory 
defaults.  

When to run Device analysis results will recommend running this test if abnormal (not default) 
settings are detected. Abnormal settings do not necessarily mean there is a need to 
set them to default values. For example, the user may want certain drive settings to 
be different from the default values, so in that case it is better to not run this test. 
However, you may also want to try restoring defaults when you suspect configuration 
parameters that could be adversely impacting operation may have been changed. 

Average duration <1 minute 

Other notes None. 

Available for 4X, 8X, and 14X MO drives. 
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Tape Edge Damage (TED) test (SDLT) 

TED test specifications 

Item Description 

Description Non-destructive test to determine if any SDLT cartridges with tape edge damage 
are present in an ESL9000 or MSL library. If the test passes, there are no tapes in 
the library with TED symptoms. If it fails, evidence of tapes with TED has been 
found, and a message is displayed indicating that the user should run the Read 
SDLT Media IDs test to locate the specific tapes with TED in the library. The 
message also instructs the user to contact HP support to identify if any of the drives 
have the potential to cause tape edge damage, and to have them replaced if any 
are identified. 

 If the TED test fails, do the following: 

1. Click the Test Results tab to view the analysis results.  

2. Record the IDs of any tapes identified for replacement. 
Note that one or more IDs may be listed more than once 
because the same tape may be identified as needing 
replacement in more than one drive in the library. 

3. Run the Read SDLT Media IDs test. This test provides a 
list of each tape in the library along with its location and 
barcode information. Match the IDs you recorded 
previously to the list to identify which tapes to replace.  

When to run Whenever you suspect symptoms of tape edge damage, or as directed by HP 
support personnel 

Average duration < 1 minute (see Read SDLT Media IDs test for duration of that test) 

Other notes This test assumes that the SDLT tapes have the proper barcode labels with “S” as 
the 7th character, that the SDLT drives have the latest firmware, and that the library 
is configured to show all barcode labels. Otherwise, the tapes may not be 
recognized with this test. 

If this test is run on a library with no SDLT 220 or SDLT 320 drives, it will not fail, 
nor will it check anything. It will return “There were no errors identified” in this case.  

Although primarily intended for libraries, this test is also supported on SDLT 220 
and 320 standalone drives. For standalone drive testing, run Device Analysis on the 
drive to get the media ID of the currently loaded tape.  

Available for ESL 9000 and MSL libraries with SDLT 220 or SDLT 320 drives,  and SDLT 220 and 
SDLT 320 standalone drives 
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Performance Tests 

About performance tests 

There are two types of performance tests integrated within L&TT (beginning with L&TT v3.3):  

 Drive performance test: This test is designed to help identify performance issues with a 
drive. The test is available on HP-UX, Linux, NetWare, OpenVMS, Tru64 UNIX, and 
Windows.  

 System performance test: This test is designed to identify performance issues within 
the system. The test is available on HP-UX, Linux, NetWare, OpenVMS, Tru64 UNIX, 
and Windows.  
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Performance-related information/recommendations 

The following link may be helpful when troubleshooting performance-related issues, or otherwise enhancing performance: 

 www.hp.com/support/pat: contains information on performance troubleshooting, 
troubleshooting tools, device transfer rates, and so on. 
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Windows 

Running drive performance tests on Windows 

The drive performance test is designed to help identify performance issues with a drive. This test writes and reads data 
to/from the specified tape drive, and calculates performance data for that drive.  

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the tape. To avoid loss of data, use a blank tape when 
performing this test. 

Note: The drive performance test is unavailable in ASPI I/O mode. You must use NT Miniport I/O mode to perform this 
test. 

To run a drive performance test on Windows: 

1. After L&TT has completed the initial scan, click either the By Product or By Connection 
tab. 

2. Click the drive to test.  

3. On the main toolbar, click the Dev Perf button. 

The Drive Performance window opens, displaying the Tape Drive Performance tab by default. 

 

Note: This test actually consists of four subtests (Step1-4) as shown in the Test Logic section of the window. You 
must chose to perform Step 1, but can choose to skip Steps 2 through 4 by selecting No Test in the 
corresponding drop-down boxes.  
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4. In the Step 1 drop-down list, select a data type. You can select from the following data 
types: 

 Zeros 
 1.6:1 Compression 
 2:1 Compression 
 3:1 Compression 
 4:1 Compression 

Note: If you choose to perform the other subtests (Steps 2-4), select one of the above data types in each of the 
corresponding drop-down list. Otherwise, select No Test.  

5. Specify the following parameters: 

 Block Mode 

o Fixed: Test uses fixed block size, which you specify in the Block Size drop-down box. 

o Variable: Test uses different data transfer mode; Block Size drop-down box is disabled. 

 Block Size: Available only if Block Mode is Fixed. Supported sizes are 16 K to 256 
K 

 I/O Size: Maximum amount of data transferred by single read/write operation. 
Typically a multiple of the Block Size and ranges from the specified Block Size to 1 
MB. 

 Test Size: Maximum amount of data written/read by the test. Choices range from 1 
GB to 15 GB. The larger the size, the more accurate the test, but the longer the test 
will run as well. 

 File Mark Mode: Writes a filemark at the specified interval (1 MB to 1 GB), or will 
write no filemarks. 

 Read After Write: When enabled, data is written to tape and then read back. Test 
measures both write and read performance. When disabled, only write performance 
is measured. 

 Rate Limiting: When enabled, the I/O rate is limited to the specified value 

6. To begin the test, click the Start button. Progress is indicated in the status bar; a dialog 
box informs you when the test is complete. 

7. To view the results of the test, click the Drive Performance Results tab. Results are 
also written to the Event Log.  

Note: See Performance-related information and recommendations for ideas on how to resolve performance issues and 
enhance performance. 
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Running system performance tests on Windows 

The system performance test is designed to identify performance issues within the system. This test writes and reads data 
to/from the specified directory,  and then calculates performance data for the backup server.  

To run a system performance test on Windows: 

1. On the main toolbar, click the Sys Perf button. 

The System Performance window opens. 

 

Note: This test actually split into two separate tests: 

 Restore pre-test: Writes to disk simulating a restore operation. (See To run a 
Restore pre-test). 

 Backup pre-test: Reads from disk simulating a tape backup operation. The 
Restore pre-test must be run before the Backup pre-test can be run. (See To 
run a Backup pre-test). 

To run a Restore pre-test on Windows: 

1. Click the Restore pre-test tab (if it is not already displayed). 

2.  Specify the following parameters: 

 Test Path: Enter the destination directory for the write data or browse using the 
Browse button. It is important for this to be a directory on the server tested. 

 Test Data Type: Select the type of data pattern to be written. You can choose from 
the following: 

o Fixed byte 
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o Incrementing 

o Random 

o Uncompressable  

o 2:1 compression ratio 

o 3:1 compression ratio 

o 4:1 compression ratio 

 File Size: Use the two drop-down boxes to specify a range of file sizes, or specify 
the same in both for fixed file size. 

 File Tree Depth: Specify the number of levels of subdirectories to create from the 
specified directory. 

 File Tree Breadth: Specify the number of directories to create within each 
subdirectory. 

 Files Per Directory: Specify the number of files to create within each subdirectory. 

Note: The Disc Capacity gauges on the Restore pre-test tab display the amount of disk space required for the 
System Performance test with current settings, along with the amount of space available in the indicated 
filesystem. If required space exceeds available space, the Test Size gauge displays OVERFLOW, and you will be 
unable to start the test. 

3. To begin the test, click Start. Progress is indicated in the status bar; a dialog box informs 
you when the test is complete. 

4. To view the results of the test, click the System Performance Results tab. Results are 
also written to the Event Log.  

To run a Backup pre-test on Windows: 

1. If you haven't already, run the Restore pre-test. 

2. Click the Backup Pre-test tab. 

3. Specify the following parameters: 

 Read Size: Specify the maximum block size in bytes to transfer. 
 Directory Traverse Method: Specify one of the following two options: 

o Depth: Test reads as far down the directory structure as possible before moving laterally to the next 
directory. 

o Breadth: Test reads all directories at the same level before moving down to the next subdirectory level. 

 Stop After: Specify the time limit for the test or select “All Readers Complete” to 
continue testing until complete. 

 Reader [1-4]: Use the Browse button to locate and enter up to four target 
directories from which the test will read data. For each Reader, you must have first 
performed a Restore pre-test. Use the same directory or directories you specified in 
the Restore pre-test(s). 

 Read Files: Specify whether the files must be read back from the tape after the 
write completes. 

4. To begin the test, click Start. A dialog box informs you when the test is complete. 
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5. To view the results of the test, click the System Performance Results tab. Results are 
also written to the Event Log.  

Note: See Performance-related information and recommendations for ideas on how to resolve performance issues and 
enhance performance. 
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HP-UX, Linux, NetWare, OpenVMS, and Tru64 UNIX 

Running drive performance tests on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

The drive performance test is designed to help identify performance issues with a drive. This test writes and reads data 
to/from the specified tape drive, and calculates performance data for that drive.  

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
  This test is destructive and will overwrite data on the tape. To avoid loss of data, use a blank tape when 
performing this test. 

Note: The screen captures that appear in this section were taken on a Linux system, but apply to HP-UX, NetWare, 
OpenVMS, and Tru64 UNIX, unless otherwise specified. Note that the screen captures are examples only; the content of 
user windows varies. 

To run a drive performance test on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. Use the select command to select the drive to be tested. 

2. In the L&TT main screen, enter devperf. 

The Device Performance Tool screen opens.  

 

3. To change any of the settings, enter the number that corresponds with the option you 
want to change. At the prompt, enter the new value. The available options for this test 
are: 

 Blocksize: Specifies the blocksize in bytes to be written to tape. Typical values are 
32768 (32 KB) & 65536 (64 KB). Default is 65536. 

 Repetitions: Specifies the number of write/read operations to perform. Defaults to 
4096. 
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 Readback: Specifies whether to perform a read of the data after it is written. When 
enabled, it will measure both read and write performance. When disabled (default) it 
will only measure write performance. 

 Count: Specifies how many blocks to write to tape per each write operation. Default 
is 16. 

 Pattern: Specifies the data pattern to be written to tape as follows: 

o 2 = 2:1 Compression (default) 

o 3 = 3:1 Compression 

4. To start the test, enter start. 

Note: See Performance-related information and recommendations for ideas on how to resolve performance issues and 
enhance performance. 
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Running system performance tests on HP-UX, Linux, OpenVMS, or Tru64 UNIX 

The system performance test is designed to identify performance issues within the system. This test writes and reads data 
to/from the specified directory,  and then calculates performance data for the backup server. The system performance 
pre-tests are not available for NetWare. 

Note: The screen captures that appear in this section were taken on a Linux system, but apply to HP-UX, OpenVMS, and 
Tru64 UNIX, unless otherwise specified. Note that the screen captures are examples only; the content of user windows 
varies. 

To run a system performance test on HP-UX, Linux, OpenVMS, or Tru64 UNIX: 

1. In the L&TT main screen, enter sysperf. 
 
The System Performance screen opens. 

Notes: This test splits into two separate tests: 

 Restore pre-test: Writes to disk simulating a restore operation (See To Run a Restore pre-test). 

 Backup pre-test: Reads from disk simulating a tape backup operation. The Restore pre-test must be 
run before the Backup pre-test can be run (See To run a Backup pre-test). 

To run a Restore pre-test on HP-UX, Linux, OpenVMS, or Tru64 UNIX: 

1. In the System Performance Screen, enter restore. 

The Restore Pre-Test screen opens. 

 

2. To change any of the settings, enter the number that corresponds with the option you 
want to change. At the prompt, enter the new value. The available options for this test 
are:  

 Filesize: Specifies the size in bytes of the test files to be created. 
 Number of Files: Specifies the number of files to be created. 
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 Directory Path: Specifies the path of the directory where the test files will be 
written. 

 Pattern: Enter the number of one of the following patterns: 

o 1 – Fixed byte 

o 2 – Incrementing byte 

o 3 – Random data 

o 4 – 1.6:1 Compressible data 

o 5 – 2:1 Compressible data 

o 6 – 3.1:1 Compressible data 

o 7 – 4.3:1 Compressible data 

3. To start the test, enter start. 

To run a Backup pre-test on HP-UX, Linux, OpenVMS, or Tru64 UNIX: 

1. If you haven't already, run the Restore pre-Test. 

2. On the System Performance screen, enter backup. 

The Backup Pre-Test screen opens.  

 

3. To change any of the settings, enter the number that corresponds with the option you 
want to change. At the prompt, enter the new value. The available options for this test 
are: 

 Blocksize: Specify the blocksize in bytes to be read. Typical values are 32768 (32 
KB) and 65536 (64 KB). Default is 65536. 

 Path: Specify the path to the directory from which to read. 

Note: See Performance-related information and recommendations for ideas on how to resolve performance issues and 
enhance performance. 
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Downloading test script files 
Beginning with the release of L&TT v3.5 SR1, downloading test script files from the web using the "Get Files From Web" 
function is no longer supported. This function was not widely used and was found to cause problems with script version 
management. Script updates will be distributed in L&TT install bundles only as part of regular L&TT releases, service 
releases (such as v3.5 SR1), or hot fixes as necessary. 

Note: On non-Windows systems, the Download Tool screen still indicates an option 6 (for more info about the script file), 
and an option 7 (to download script files). However, beginning with L&TT v3.5 SR1, if you select one of these two options, 
the resulting screen is blank. In the future, a message will be displayed to inform you that these functions are no longer 
available. 
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Support Tickets 

About support tickets 
A major feature of L&TT is the ability to generate a support ticket. In the event of a hardware problem, a support ticket can 
provide vital information to help diagnose and resolve the problem. Support ticket generation is supported by each of the 
operating systems supported by L&TT. 

Note: With ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, if L&TT is used to 
generate a support ticket, it will not include the IM and IFC logs. Unless otherwise instructed by HP support personnel, 
support tickets should be generated using the Command View ESL GUI or CLI, as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide, to ensure that all log data is captured. When the libraries are 
partitioned, extra care should be taken in interpreting support tickets because the values in the logs are based on the 
actual physical library, not the partitioned library, so drive and slot numbers do not directly match those numbers reported 
by the backup application. 

When you generate a support ticket, L&TT collects configuration information and executes a Device Analysis test on the 
selected device. This information can then be viewed, saved, and printed, compared to another support ticket, or emailed. 
A support ticket is saved as a log file containing the .ltt extension. By default, log files are saved to the “logs” directory. 

Notes:  

 Regardless of the selected detail level, the log file always contains all the information collected from the 
product. The support ticket viewer filters this information, depending on the detail level selected. 

 Viewing support tickets is cumbersome in non-Windows operating systems. Comparing or printing of 
support tickets is only supported on Windows. Emailing support tickets is supported on all L&TT supported 
operating systems with the exception of NetWare. HP recommends that you view support tickets on 
Windows to provide unrestricted analysis. 

Support tickets can get quite large, especially in the case of libraries that support more than a single drive. L&TT supports 
certain size management facilities that help ensure support ticket size is manageable. See Support ticket size 
management for more information. 
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Support ticket size management 
Two primary changes were introduced with L&TT v3.4 regarding support ticket size management. They are: 

 Compression of support tickets. 

 Support for splitting large support tickets into smaller, more manageable chunks 
(Windows only). L&TT v3.5 added support for splitting support tickets for non-Windows 
platforms. 

These changes were made primarily to eliminate problems associated with emailing very large files. 

Support ticket compression 

As of L&TT v3.4, support ticket compression is now supported for both Windows and non-Windows platforms, making 
them easier to handle. Support ticket compression is enabled on Windows by default, and disabled on non-Windows. In 
both cases, compression ratio averages 5:1 when enabled. Compressed support tickets cannot be saved in L&TT. 
However, when a compressed support ticket is emailed, it can be extracted from the email and saved if desired. If you 
extract the compressed file and check the file extension, notice that it has an .ltt.lzo extension rather than the usual .ltt 
extension. Click here to see what a support ticket of this type looks like when it is opened in the L&TT Support Ticket 
Viewer. Compressed support ticket files are not viewable on non-windows platforms. Regardless of platform, compressed 
support tickets are created during the send/email process only.  

 

If you have a concern about transferring binary files, there is a check box in the Email Support Ticket dialog box that 
lets you disable support ticket compression on Windows so that it will not compress the support ticket files. Compression 
can be later re-enabled if desired via the same dialog box. For non-windows platforms compression is disabled by default. 
If you wish to enable, use option 12 from the "send screen" (click here for instructions on how to get to the support ticket 
screen, and type "send" from that screen). This same screen can also later be used to disable compression if desired. 
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Splitting large support tickets on Windows 

As mentioned, this support was first implemented in L&TT v3.4, and is designed to avoid problems that can occur when 
you attempt to email very large files. A normal standalone drive support ticket consists of a single file with the .ltt file 
extension. The ticket is displayed in standard tree view format. The user or support person can change the detail level by 
clicking the + and - signs, and then selecting the desired current detail level setting in the drop-down box.  

With a “split” support ticket, a file with an .ltt extension is still created, but several additional files are also created. Each of 
these additional files has a .dat file extension and represents a sub-ticket. When you open the .ltt file in the usual way for 
viewing, the additional sub-ticket files are accessible via hyperlinks. After the ticket is opened in the L&TT viewer, you can 
observe the hyperlinks (Show me).  
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In the above split support ticket example screen shot, there are several hyperlinks to .dat files under the Detailed Device 
Information section. When the cursor is positioned over one of these hyperlinks, it is highlighted (as shown in the 2nd line 
of the screen shot). After you click the hyperlink, the respective .dat file is located and loaded into memory, and can then 
be expanded for detailed viewing. In the example, the first line in the Detailed Device Information section has already 
been clicked and loaded into memory. Note that it has a + to allow expansion of the file details.  

Notes:  

 All support tickets for libraries that can have more than one drive (whether or not they actually have more 
than one drive configured) are split into multiple files. Autoloaders and standalone drives will not have split 
support tickets. The additional files created with a split support ticket MUST be included when the ticket is 
sent for analysis. If the ticket is emailed from within L&TT, the additional .dat files are included in the email 
automatically. If the support ticket is sent using an email external to the L&TT application, you need to 
manually attach all of the associated .dat files to the email. Otherwise, HP support personnel will not have 
the information they need to do a proper analysis. 

 If the .ltt and .dat files associated with a split support ticket exceed the 10 MB default value for maximum 
email size, L&TT automatically generates separate email messages to keep the size below the threshold. 
(This maximum email size limit only pertains to emails sent from within L&TT.) The default value for 
maximum email size is 10 MB, but is configurable using the Preferences dialog box. 
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Splitting large support tickets on HP-UX, Linux, NetWare, OpenVMS, or 
Tru64 UNIX 

For the non-Windows platforms, support for split support tickets was first implemented in L&TT v3.5, and is designed to 
avoid problems that can occur when you attempt to email very large files. A normal standalone drive support ticket 
consists of a single file with the .ltt file extension. Click here to see what a support ticket of this type looks like when it is 
opened in the L&TT Support Ticket Viewer. 
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Use the ^U and ^D commands to scroll up or down respectively to view the contents of the support ticket. 

When you enter a view, save, or send command from the L&TT Support Ticket screen, it automatically generates a split 
support ticket. With a “split” support ticket, a file with an .ltt extension is still created, but several additional files are also 
created. Each of these additional files has a .dat file extension and represents a sub-ticket (show me).  

 

In the above example screen shot, the a5617a.ltt file is the primary support ticket file that was created for the A5617A 
library, and the three .dat files that begin with “88” are the associated additional files for that support ticket. You will not be 
able to view the additional support ticket information contained in the .dat files through the Support Ticket Viewer on non-
Windows platforms. However, you can transfer the .ltt file and all associated .dat files to a Windows platform machine and 
view all the data there.  

Notes:  

 All support tickets for libraries that can have more than one drive (whether or not they actually have more than 
one drive configured) are split into multiple files. Autoloaders and standalone drives will not have split support 
tickets. The additional files created with a split support ticket MUST be included when the ticket is sent for 
analysis. If the ticket is emailed from within L&TT, the additional .dat files are included in the email 
automatically. If the support ticket is sent using an email external to the L&TT application, you need to manually 
attach all of the associated .dat files to the email. Otherwise, HP support personnel will not have the information 
they need to do a proper analysis. 
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 If the .ltt and .dat files associated with a split support ticket exceed the 10 MB default value for maximum email 
size, L&TT automatically generates separate email messages to keep the size below the threshold. (This 
maximum email size limit only pertains to emails sent from within L&TT.) The default value for maximum email 
size is 10MB, but is configurable using the preferences option. 
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Windows 

Generating support tickets on Windows 

Generate a support ticket to provide vital information to help diagnose and resolve a problem. When you generate a 
support ticket, L&TT collects configuration information and executes a Device Analysis test on the selected device. 

Note: When generating a support ticket for standalone devices, HP recommends you keep the media that was present in 
the drive when the failure occurred in the drive. This allows error rate and other information relevant to that cartridge to be 
examined. When media is removed, many devices automatically clear this information. For tape automation products, it is 
generally better to have the drives empty of media to force the library drive/media log to be updated. 

Note: With ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, if L&TT is used to 
generate a support ticket, it will not include the IM and IFC logs. Unless otherwise instructed by HP support personnel, 
support tickets should be generated using the Command View ESL GUI or CLI, as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide, to ensure that all log data is captured. When the libraries are 
partitioned, extra care should be taken in interpreting support tickets because the values in the logs are based on the 
actual physical library, not the partitioned library, so drive and slot numbers do not directly match those numbers reported 
by the backup application. 

To generate a support ticket on Windows: 

1. Select a device in the device list (using By Product or By Connection tab), and then click 
the Support button on the Main toolbar. 

The Support window opens. 

 

Note: The bottom section of the Support window provides resources for finding support on the Web. Click any of 
the buttons in the Support Resources on the Web section to display the corresponding web site in a browser 
window. 

2. The Support window displays three options for generating a support ticket. Each of the 
following three options has a corresponding button in the Generate Support Tickets 
section: 
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 View Support Ticket: Click this button to generate the support ticket and 
immediately view it in the support ticket viewer. The support ticket can later be 
saved or sent via email.  

 Save Support Ticket to File: Click this button to generate and save the support 
ticket. The support ticket is saved as a log file with the .ltt extension. The support 
ticket can later be viewed or sent via email. To view a saved support ticket, open it 
through Windows Explorer, or use the Load command on the File menu. 

 Send Support Ticket by Email: Click this button to generate the support ticket and 
immediately send it via email to an HP support center (or other destination). 
Clicking this button opens a form that allows you to provide all the necessary 
information. Complete the form and click the Send button to send the email. Using 
this option does not save a copy of the support ticket locally; click Save Support 
Ticket to File to save a copy for future reference.  
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Viewing, saving, and printing support tickets on Windows 

L&TT support tickets are created in a proprietary format and therefore require the Support Ticket Viewer. 

 

The Support Ticket viewer is built into the L&TT application. The viewer enables viewing of detailed device information 
and general information on the system to which it is connected. This information is displayed in a standard Tree view 
format. The user, or support person, can change the detail level of the support ticket, browse through the support ticket 
information, and expand or collapse specific sections of the support ticket as required. 

To view a support ticket on Windows: 

1. Click the “+” and “-“ signs to expand and collapse sections of the support ticket. 

2. Use the standard navigation keys ( Home, End, Page Up, Page Down), the arrow keys, 
or the Windows scroll bars to navigate through the ticket. 

3. You can display support ticket information in several different levels of detail, dependent 
on the setting displayed in the Current Detail Level drop-down list within the Support 
Ticket viewer. The following detail levels are available: 

 Highlights only 
 Normal (shown in above example screen shot from “current detail level”) 
 More detail 
 Everything (the highest level an end user can view) 
 Factory only (requires factory password; available to HP support personnel 

only) 



L&TT Support Guide (End User Edition) 

146 

4. You can right-click any node (line) in the support ticket viewer to display a context menu 
that exposes additional functionality. Depending on the node that was clicked, the 
following items may or may not be available (unavailable items will be dimmed): 

 Expand all: Select this item to expand all subitems in the node. 
 Event explanation: Select this item to open the “event” window, displaying 

additional information about the event. You can view the data in either ASCII or 
hexadecimal format. This feature is available for items preceded with the blue 

information icon (  ). 
 Event data: Select this item to open the “event data” window, displaying L&TT 

specific information about the event. 
 Copy: Select this item to copy the current line to the Windows clipboard 
 Reference data: Select this item to open the “reference data” window, displaying 

reference information pertinent to the current line, such as valid ranges and 
applicable values.  

To save a support ticket on Windows: 

Click the Save Support Ticket to File button to save a local copy of the file. HP recommends saving a copy 
locally. 

To print a support ticket on Windows: 

From the Support Ticket Viewer menu, click File > Print. 

Note: When running L&TT on Windows, you can also convert a support ticket to HTML format using the currently selected 
detail level. Do so by clicking File > Generate HTML Report while viewing the support ticket. The HTML version can 
easily be printed or viewed by other users without the support ticket viewer.  
 
If sending to HP support personnel, HP recommends that the HTML format NOT be used unless otherwise instructed by 
an HP support representative. After an HTML support ticket has been generated, the detail level within the HTML file 
cannot be changed. Make sure that the detail level is set to the desired level before generating the HTML report. 
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Emailing support tickets on Windows 

You can generate a support ticket and immediately send it via email to an HP support center (or other destination). 

Note: Before L&TT can email a support ticket, you must either have a MAPI-compliant email program (such as Microsoft 
Outlook or Outlook Express), or you must set up an email account through the Windows Control Panel or Internet 
Explorer.  

To email a support ticket on Windows: 

Note: L&TT defaults to 10 MB for maximum size for any email. If your email setup will not permit email files as large as 10 
MB, click L&TT Options > Preferences, click the check box for maximum email size, and then enter a smaller number. If 
you attempt to email a support ticket using L&TT that is larger than the selected maximum email size, L&TT breaks the 
email into smaller, separate emails so that they do not exceed the maximum size limit. 

1. In the Support window, click Send Support Ticket by Email. 

The Email Support Ticket dialog box opens. 
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2. Enter the appropriate information, and then select the email address to which you want to 
send the support ticket. If you are using a version of L&TT prior to v3.5, do not use the 
regional email addresses; these addresses are no longer monitored. Beginning with v3.5, 
two valid email addresses are offered, both for the North American region: 

 LTT North America Support Call Center (for all North America except 3rd party 
outsourcer use) 

 LTT North America Support Call Center 20 (for 3rd party outsourcer use) 

Note: Customer support personnel typically provide an email address to users who are emailing a support ticket as a 
result of a support call request. In this case, the user should enter the email address exactly as provided by the support 
person. In the European region this will usually be provided in the form:  "xxxxxxxxxx@cases.brussels.hp.com" where 
"xxxxxxxxxx" is the actual assigned case number. This associates the support case number with the support ticket making 
resolution and tracking more manageable. 

To set up an email account on Windows: 
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Even if email software (such as Outlook or Outlook Express) is not installed, you can configure a simple email account 
using the Internet Connection Wizard that comes with Internet Explorer. To access the Internet Connection Wizard: 

1. Launch Internet Explorer. If this is the first time to launch Internet Explorer on this 
machine, the Internet Connection Wizard opens automatically. Follow the instructions 
until you reach the step that asks whether an Internet email account should be set up. 
Answer Yes and skip to Step 5. If this is not the first time to launch Internet Explorer on 
this machine, proceed with Step 2. 

2. Click Tools > Internet Options. 

3. Click the Connections tab. 

4. Click Setup at the top of the dialog box. 

The Internet Connection Wizard opens. 

5. Enter a display name (this is the “From” name in the email), and then click Next. 

6. Enter the return email address, and then click Next. If there are no email accounts on this 
system that will be monitored, use your regular email address at which you can be 
contacted by the recipient of the support ticket. 

7. Enter bogus as the address for the incoming mail server. 

8. In the SMTP mail server box, enter the address of any SMTP mail server within the 
firewall of your organization that accepts SMTP send requests, and then click Next. If you 
do not know which address to use, contact your local system administrator or check the 
mail account settings on your regular email account. 

9. If your SMTP server requires a logon to send email (most sites only require a logon for 
incoming mail), you must provide proper account information. Otherwise, you can enter 
bogus in both fields. Click Next. 

Note: Your email is now configured for outgoing mail delivery. 
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Comparing support tickets on Windows 

L&TT can compare two support tickets and generate a report containing the differences. This can be helpful when 
troubleshooting a problem because it highlights the changes since a previous support ticket was generated. 

To compare support tickets on Windows: 

1. Generate or open the first support ticket to be compared. 

2. In the support ticket viewer, click File > Compare. 

The Open dialog box opens. 

3. Select the support ticket to which you want to compare the first ticket, and then click 
Open. A new window opens with the comparison results.  
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Generating event logs on Windows 

L&TT can generate a detailed event log that captures all L&TT diagnostic interaction with the product, all SCSI commands 
sent and received by the program, and any software interactions or issues. By default, the event log is not accessible until 
the factory password has been entered, and therefore is unavailable to end users. Its content is intended for use by L&TT 
programmers as a tool for debugging software issues within the program itself.  

To generate an event log on Windows: 

1. Run L&TT. 

2. Click Options > Preferences. 

3. Click the Add I/O History to Event Log option, and then click OK. 

Note: Disable the Add I/O History to Event Log option as soon as you send the email; it can use hundreds of 
megabytes of disk space. To disable it, return to L&TT, click Preferences on the Options menu, clear the Add I/O 
History to Event Log option, and then click OK. 

4. Exit L&TT, and then restart it. 

5. Reproduce the problem encountered. 

6. Navigate to the logs directory in the L&TT installation directory, and then locate the 
Eventlog.ltt file. 

7. Attach the file to an email, and then send it to the L&TT team for diagnosis. 

8. Return to L&TT, and then click Options > Preferences. 

9. Clear the Add I/O history to event log option, and then click OK.  

Note: Because the event log stores a SCSI trace of the interaction between the product and the L&TT software, it can be 
used as a simple SCSI analyzer. You may be directed by HP support personnel to generate an event log with the "Add I/O 
history to event log" option enabled.  
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HPUX, Linux, NetWare, OpenVMS, and Tru64 UNIX 

Navigating to a Support Ticket screen 

You can generate a support ticket that provides vital information to help diagnose and resolve a problem. When you 
generate a support ticket, L&TT collects configuration information and executes a Device Analysis test on the selected 
device. 

To navigate to an initial Support Ticket screen: 

1. In the L&TT main screen, select the device for which you want to create a support ticket. In 
our example, you would enter select 1. 

 

If the selected device is a standalone drive, the Drive Information screen opens. If the selected device is an 
autoloader or library, the Device Identity screen opens.  
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2. Enter support. 

The Support Ticket screen opens. 
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Note: If the support ticket is for a standalone drive, the Support Ticket screen menu bar displays main > drive 
information > support ticket rather than main > identity > support ticket. 

3. After the support ticket screen opens, you can generate and then view, save or email a 
support ticket. 
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Generating and viewing support tickets on HP-UX, Linux, NetWare, 
OpenVMS, or Tru64 UNIX 

Note: When generating a support ticket for standalone devices, HP recommends that you keep the media in the drive on 
which it was present when the failure occurred. This allows error rate and other information relevant to that cartridge to be 
examined. When media is removed, many devices automatically clear this information. For tape automation products, it is 
generally better to have the drives empty of media to force the library drive/media log to be updated. 

Note: With ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, if L&TT is used to 
generate a support ticket, it will not include the IM and IFC logs. Unless otherwise instructed by HP support personnel, 
support tickets should be generated using the Command View ESL GUI or CLI, as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide, to ensure that all log data is captured. When the libraries are 
partitioned, extra care should be taken in interpreting support tickets because the values in the logs are based on the 
actual physical library, not the partitioned library, so drive and slot numbers do not directly match those numbers reported 
by the backup application. 

To generate and view a support ticket on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. Navigate to the Support Ticket screen. 

2. In the Support Ticket screen, enter view to generate a support ticket for viewing. (Show 
me) 

 

3. After you enter the view command, L&TT generates the support ticket. The status area at 
the bottom of the screen informs you that the support ticket data is being generated. 
(Show me) 
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4. After the support ticket is generated, the Viewer screen opens. 

 

5. Use the ^U and ^D commands to scroll up or down respectively to view the entire support 
ticket. 
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Generating and emailing support tickets on HP-UX, Linux, or Tru64 UNIX 

Note: When generating a support ticket for standalone devices, HP recommends that you keep the media in the drive on 
which it was present when the failure occurred. This allows error rate and other information relevant to that cartridge to be 
examined. When media is removed, many devices automatically clear this information. For tape automation products, it is 
generally better to have the drives empty of media to force the library drive/media log to be updated. 

Note: With ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, if L&TT is used to 
generate a support ticket, it will not include the IM and IFC logs. Unless otherwise instructed by HP support personnel, 
support tickets should be generated using the Command View ESL GUI or CLI, as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide, to ensure that all log data is captured. When the libraries are 
partitioned, extra care should be taken in interpreting support tickets because the values in the logs are based on the 
actual physical library, not the partitioned library, so drive and slot numbers do not directly match those numbers reported 
by the backup application. 

You can generate a support ticket and immediately send it via email to an HP support center (or other destination). 
Emailing a support ticket is supported on HP-UX, Linux, and Tru64 UNIX beginning with L&TT v3.4, but is not supported 
on NetWare or OpenVMS. 

To generate and email a support ticket on HP-UX, Linux, or Tru64 UNIX: 

Note: L&TT defaults to 10 MB for maximum size for any email. If your email setup will not permit email files as large as 10 
MB, you can change this value (see To set preferences and passwords for L&TT on HP-UX, Linux, NetWare, OpenVMS, 
or Tru64 UNIX). If you attempt to email a support ticket using L&TT that is larger than the selected maximum email size, 
L&TT breaks the email into smaller, separate emails so that they do not exceed the maximum size limit. 

1. Navigate to the Support Ticket screen. 

2. In the Support Ticket screen, enter send to generate a support ticket. 

The Send screen opens to email the support ticket. Enter 1 to begin entering information for the support ticket. 
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3. Select an email address. If you are using a version of L&TT prior to v3.5, do not use the 
regional email addresses; these addresses are no longer monitored. Beginning with v3.5, 
two valid email addresses are offered, both for the North American region: 

 LTT North America Support Call Center (for all North America except 3rd party 
outsourcer use) 

 LTT North American Support Call Center 20 (for 3rd party outsourcer use) 

Note: Customer support personnel typically provide an email address to users who are emailing a support ticket 
as a result of a support call request. In this case, the user should enter the email address exactly as provided by 
the support person. In the European region this will usually be provided in the form: 
"xxxxxxxxxx@cases.brussels.hp.com" where "xxxxxxxxxx" is the actual assigned case number. This associates 
the support case number with the support ticket making resolution and tracking more manageable. 

4. After selecting an email address, if this is a currently open case, enter 2, and then enter 
the reference number at the prompt. If this is not a currently open case, proceed to the 
next step. 

5. Enter 3, and then enter the product ID when prompted. 

6. Enter 4, and then enter the serial number of the selected device when prompted. 

7. Enter 5, and then enter your company name when prompted. 

8. Enter 6, and then enter your contact name when prompted. 

9. Enter 7, and then enter your phone number when prompted. 

10. Enter 8, and then enter your email address when prompted. 

11. Enter 9, and then enter a brief description of the problem when prompted. 

12. Enter 10 and select the option to attach the result log when prompted. 

13. Enter 11 and select the option to attach the event log only if requested by HP Support. 
The event log does not typically need to be sent.  

14. Enter 12 and select the option to compress the support ticket files. After all of the above 
steps have been completed, the screen should look similar to this screen shot.  
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15. Enter the send command to send the support ticket. When the support ticket is being 
generated and sent, the status bar at the bottom of the screen indicates the progress. 



L&TT Support Guide (End User Edition) 

160 

Generating and saving support tickets on HP-UX, Linux, NetWare, 
OpenVMS, or Tru64 UNIX 

Note: When generating a support ticket for standalone devices, HP recommends that you keep the media in the drive on 
which it was present when the failure occurred. This allows error rate and other information relevant to that cartridge to be 
examined. When media is removed, many devices automatically clear this information. For tape automation products, it is 
generally better to have the drives empty of media to force the library drive/media log to be updated. 

Note: With ESL9000 Series with Command View ESL, ESL E-Series, and EML E-Series libraries, if L&TT is used to 
generate a support ticket, it will not include the IM and IFC logs. Unless otherwise instructed by HP support personnel, 
support tickets should be generated using the Command View ESL GUI or CLI, as documented in the HP StorageWorks 
Interface Manager and Command View ESL User Guide, to ensure that all log data is captured. When the libraries are 
partitioned, extra care should be taken in interpreting support tickets because the values in the logs are based on the 
actual physical library, not the partitioned library, so drive and slot numbers do not directly match those numbers reported 
by the backup application. 

To generate and save a support ticket on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. Navigate to the Support Ticket screen. 

2. In the Support Ticket screen, enter save and a name for the saved file. (Show me) 

 

In the example screen shot, the command save support.ltt was entered to generate and save the support ticket 
with the name support.ltt. 

3. After you enter the save command, L&TT generates and saves the support ticket. The 
status area at the bottom of the screen informs you that the support ticket data is being 
generated. 

After the support ticket is saved, you are returned to the command prompt screen. 
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Printing support tickets on HP-UX, Linux, NetWare, OpenVMS, or Tru64 
UNIX 

Support ticket printing is not supported on non-Windows platforms. To print a support ticket, transfer the file to a Windows 
system, and then print the ticket. (See Viewing, saving, and printing support tickets on Windows.) 
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Comparing support tickets on HP-UX, Linux, NetWare, OpenVMS, or Tru64 
UNIX 

Support ticket comparing is not supported on non-Windows platforms. To compare support tickets, transfer the file(s) to a 
Windows system, and then compare the tickets. (See Comparing support tickets on Windows.) 
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Generating event logs on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

L&TT can generate a detailed event log that captures all L&TT diagnostic interaction with the product, all SCSI commands 
sent and received by the program, and any software interactions or issues. By default, the event log is not accessible until 
the factory password has been entered, and is therefore unavailable to end users. Its content is intended for use by L&TT 
programmers as a tool for debugging software issues within the program itself.  

To generate an event log on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. Run L&TT. 

2. In the L&TT main screen, enter preferences. 

The Preferences screen opens. 

 

3. Enter the number associated with the Add IO History to Eventlog option to enable it. 

Note: Disable the Add I/O History to Event Log option as soon as you send the email; it can use hundreds of 
megabytes of disk space. To disable it, return to L&TT Preferences window, and then enter the number 
associated with the Add IO History to Eventlog option.  

4.  Exit L&TT, and then restart.  

5. Reproduce the problem encountered. 

6. Navigate to the “/opt/ltt/logs” directory and enter Is to locate the eventlog.ltt file. 

7. Attach the file to an email, and then send to the L&TT team for diagnosis. 
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Common Questions/Scenarios 

Why should I generate and/or email support tickets 
Support Ticket Statement: Much of the information stored within the device related to operation characteristics is used 
by the tests themselves to analyze the health of the device. However, not all information can be used in this automated 
fashion. Some information requires review by qualified HP personnel to fully diagnose the user situation. It is for this 
reason a support ticket should be generated and emailed for further analysis when requested. 

Support ticket email addresses 

Support varies somewhat depending on the region. If you are using a version of L&TT prior to v3.5, do not use the 
regional email addresses. These address are no longer monitored. Beginning with v3.5, two valid email addresses are 
offered, both for the North American region. 

 LTT North America Support Call Center (for all North America except 3rd party 
outsourcer use) 

 LTT North America Support Call Center 20 (for 3rd party outsourcer use) 

Note: Customer support personnel typically provide an email address to users who are emailing a support ticket as a 
result of a support call request. In this case, the user should enter the email address exactly as provided by the support 
person. In the European region this will usually be provided in the form: "xxxxxxxxxx@cases.brussels.hp.com" where 
"xxxxxxxxxx" is the actual assigned case number. This associates the support case number with the support ticket making 
resolution and tracking more manageable. For more information on support tickets, please see About support tickets. 
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Why should I install L&TT 
Installation Statement: HP StorageWorks L&TT is a robust tape & optical diagnostic utility that helps ensure proper 
problem diagnosis and installs in just a few minutes. 

 I am concerned it may take a long time to install (see HP-UX, Linux, Linux-64, NetWare, 
OpenVMS, Tru64 UNIX, and Windows). 

 I am concerned that if I install it will cause a reboot to occur (see HP-UX, Linux, Linux-64, 
NetWare, OpenVMS, Tru64 UNIX, and Windows). 

 I have previously had a bad experience with an L&TT installation (see HP-UX, Linux, 
Linux-64, NetWare, OpenVMS, Tru64 UNIX, and Windows). 

 My management will not allow me to install applications on the server, or I'm nervous to 
install L&TT on my server. 

 I have an older version of L&TT installed, so why should I update? 
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Why should I run L&TT tests 
L&TT Test Statement: HP StorageWorks L&TT tests are specifically designed to ensure proper diagnosis of user 
problems with tape and optical devices. The tests interrogate internal drive registers for logged data  from normal 
operations, as well as data-gathering during operations performed by the test. This helps to pinpoint the user problem and 
prevents a drive swap that won’t resolve the issue. 

 I am concerned that L&TT tests take too long to run 

 I am concerned that L&TT tests never show anything and are a waste of time 

 I cannot run tests because L&TT is in restricted mode 
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I have tape compatibility questions 

 I am unclear what data tapes are compatible with my DDS drive 

Note: The recommended media for each type of drive is its native media. For example, DDS-1 media is 
recommended for DDS-1 drives, DDS-2 media for DDS-2 drives, and so on. 

 I am unclear what data tapes are compatible with my DLT drive 

 I am unclear what data tapes are compatible with my LTO drive 

 I am unclear what data tapes are compatible with my AIT drive 

 I am unclear what cleaning tapes are compatible with my drive: 

 DLT 

 LTO 

 DDS: Standard DDS cleaning cartridge is supported. 

 AIT 
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I have device compatibility/support questions 

 What hardware is my drive supported on? 

 What software is my drive supported on? 

 Is my device supported by L&TT? 

 What hardware/software is my library/autoloader supported on? 

 Is there a matrix that cross references a drive's product name, format, and part number? 

Note: Click here to access general information about tape product compatibility. 
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I have tape drive cleaning questions 

 What are cleaning requirements for my SDLT drive? 

 What are cleaning requirements for my DLT or VS80/DLT1 drive? 

 What are cleaning requirements for my LTO drive? 

 What are the cleaning requirements for my DDS drive? 

Note: Click here to access the combined tape cleaning matrix for all tape drive types. In case of any conflicting 
information, this matrix is the final reference. 
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Miscellaneous L&TT 

L&TT change highlights per version 
This section highlights the major changes implemented with each version of L&TT. It is best to always run the latest 
version possible to take advantage of the latest tests and functionality. If you need information related to installing the 
latest version, see Installation requirements. 

Click on a heading below to view release details: 

L&TT Version 3.5 SR1 (released September 2004) 

 Various test/script enhancements 

 Added SDLT Tape Edge Damage (TED) detect test to test for TED in libraries, 
and the Read SDLT Media IDs test to help locate any cartridges determined to 
have TED by the TED test or other log entries 

 ESL E-Series library test/script enhancements 

 Event text for ESL E-Series libraries now read from firmware instead of 
shipped with L&TT to improve synchronization with newly released 
firmware 

 Added Device Analysis content for ESL E-Series library 

 Updated LTO Device Analysis test 

 Added new rule for detection of stuck tapes 

 Where appropriate, updated messaging to recommend HP media, 
recommend running the LTO Assessment test, and indicate the rule 
number 

 Enhanced interpretation of the Tape Usage log 

 Removed firmware revision check (see also LTO Assessment test) 

 Various Acceptance test enhancements 

 Renamed Acceptance test family to Assessment test family 

 Added 1/8 Autoloader Assessment test 

 Updated LTO Assessment test 

 Check added to avoid long execution time (end test if first 10 writes 
exceed two minutes in duration) 

 Change made to always report sense data during write errors 

 Added firmware revision check test option to accommodate sites having 
firmware upgrade policies 

 Updated SDLT Assessment test 

 Removed MAM information which was causing problems and not 
required for the test 
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 Updated DLT1/VS80 Assessment test 

 Added support for COMPAQ DLT1 drive 

 Removed “Get Files From Web” feature to update L&TT script files 

 This function saw low usage and caused problems with script version 
management. Script updates now distributed as L&TT install bundles 
only. 

 Added DLT 7000 support to DLT SRAM Check tests (long and short) 

 Fixed several L&TT defects 

 Fixed problem where DDS4 support tickets did not report correct OBDR support 

 Fixed various 1/8 autoloader problems with SDLT 320 and Ultrium 460 drives 

 Fixed problem where log pages were not properly decoded 

 Fixed problem where firmware revisions were not decoded correctly and 
could become unselectable 

 Fixed problem where devices on certain HP-UX HBAs were not recognized by 
L&TT 

 Fixed Assessment test problem where DDS3 drive may fail load sequence 

 Fixed Tape Erase test failures where erase pass counter may be incorrect and 
EOD is incorrectly determined 

 

L&TT Version 3.5 (released May 2004) 

 Added support for OVMS 7 (Alpha platform), and NetWare 6.5. 

 Added device support for the UDO drive and libraries, and support for ESL E-Series Tape 
Library with native FC drives and FC - FC bridge. 

 Various test/script enhancements. 

o L&TT Install Check functionality now supports SDLT 320 and VS80 drives. 

o Revised Acceptance test (new device support, rules updates, and so on). 

o Added support for DDS drives. 

o Updated LTO Acceptance test with latest version of LTO Device Analysis rules. 

o Updated SDLT Acceptance test. 

o Added library specific messaging. 

o Divided write portion of error-rate test into sections to improve test 
time for poor-performing drives. 

o Changed "Drive/Media Interaction test" option name to "Media test," 
and changed test option messaging. 

o Revised Firmware Tape Creator test (new device support). 
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o Added support for DDS (DDS4 & DAT72 only). 

o Revised Device Analysis test (new device support, rules updates, and so on). 

o Revised order of rule evaluation in DDS Device Analysis test, and added support 
for fault log error 0x54 for rule U1. 

o Added capacity loss rule, and SCSI performance rule to LTO Device Analysis test. 

o Updated SDLT Device Analysis test to add output for compression data, and Media 
ID and clean count information.  

o Added UDO Device Analysis test. 

o Added support for Sony DDS3/DDS4 to Compression test, and improved messaging if compression 
was disabled prior to running test. 

o Added secure erase test option to Tape Erase test, and changed messaging to use test options 
rather than dialog pop-ups. 

 Improved performance of L&TT in SAN environments. 

o Now saves device scans by default to eliminate the need to scan hardware every time L&TT 
started.  

o Integrates this improved functionality into the user interface for ease of use. 

o Can now select more than one device to be scanned. 

 Tool Status Reports now available for non-Windows platforms, as well as Windows 
platforms. 

 Split support tickets now enabled on non-Windows platforms, as well as Windows 
platforms. 

 Removed inactive L&TT Call Center e-mail addresses for regions outside North America. 

 Fixed several L&TT defects. 

o Fixed problem running Library Exerciser test on C7200 library where wrong error message 
displayed. When drive is full, running Library Exerciser test displays meaningless error message. 

o Fixed problem where firmware updates fail on DAT 40x6 autoloader running H310 (or later) 
firmware.  

o Addressed "specified file not found" error running device performance tool on Win9x/ME or other 
Windows OS running ASPI I/O mode by disabling the test when running in ASPI I/O mode. The 
performance tool is not supported on Win9x or other Windows OS running ASPI I/O mode due to 
lack of NT Miniport support. 

o Improved messaging implemented in Acceptance test results log to prevent displaying some 
messages out of order, making it hard to interpret. 

o Fixed problem introduced in v3.4 SR1 with DAT72 media displaying as DDS1/60m in DAT72 drive 
and autoloader. 

o Improved error logging/messaging on HP-UX I/O scan when errors occur during scan. 

o Fixed problem with Media Analysis test failures with large block sizes. If data block encountered that 
exceeds OS transfer size, new error message now flags this rather than looking like a test failure. 

o Fixed problem on Linux where Get Files From Web would fail if non-standard folder used. 

o Various support ticket related fixes. 
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o Fixed problem introduced in v3.4 SR1 losing "newlines" when saving support ticket 
attached text logs, making them difficult to read. Problem on ESL, ESL-E with 
CommandView generated support tickets on Windows. 

o Fixed Support Ticket Viewer crash problem on split support tickets on Windows 
after expanding a ticket and clicking on an anchor line for various libraries. 

o Fixed problem introduced in v3.4 SR1 where Bin Pick and Place retry counts not 
decoded in support ticket for ESL-E library. 

o Improved SCSI Cmd history formatting in LTO support ticket. 

o Fixed problem introduced in v3.2 where support ticket wasn't decoding timestamps 
in the fault and cmd history logs to the sub-second level for LTO2. 

o Fixed problem where library support tickets reporting multiple LTO drives contain 
duplicates of last drive trace logs for all drives. 

L&TT Version 3.4 SR1a (released February 2004) 

 Added support for Red Hat Linux 9.0. 

 Added device support for ESL E-Series Tape Library, DAT 72x6 autoloader and 1/8 
autoloader with SDLT320 drives. 

 Various test/script enhancements: 

o Improved firmware update message boxes on Windows 2K to set user expectations and give 
instructions to eliminate the need to call support. 

o Updated DDS autoloader rules for correct revdata info and consistent device analysis messaging. 

o Miscellaneous compression test changes - Addressed interaction issue with compression test and 
Windows backup, and eliminated “compression disabled/enabled” messages that occurred during 
compression test. Also added support for DLT 4000 CPQ DRV and decreased DDS test time. 

o Updated DLT drive rules to change compression messaging. 

o Updated DLT firmware tape creator test to support DLT 4000 CPQ DRV. 

o Revised SDLT acceptance test to add specific messaging for library drives, split write error rate 
section to provide quicker exit with poor performing drive, and added “drive/media interaction test” 
option to help determine goodness of drive vs. tape, and help flag tape with edge damage. 

o Revised Ultrium acceptance test so that device analysis is run first after initial tape load. Also 
corrected a capacity loss issue, updated device analysis portion, and added frequent status updates 
during write section. 

o Updated Ultrium drive rules to publish LTO-1 230 SCSI config information in factory-only detail 
level, and cartridge serial number in "everything" detail level (if cartridge currently loaded). 

 L&TT Windows installer now requires uninstall of previous version before new install to 
avoid reliability problems during upgrades. In some rare cases the install may still fail and 
a separate cleanup utility will need to be run to completely uninstall the old version and 
allow the new version to be successfully installed. If this occurs, go to the L&TT product 
page, click the link for the Windows operating system you are running, and then click the 
"HP StorageWorks Library and Tape Tools Install Support Setup" link to download the 
hp_ltt_install_support.exe utility. Once downloaded, run this utility to clean up all old 
install files, then retry the L&TT installation procedure. 

 Fixed several L&TT defects: 

o Removed Media Validation test whenever Media Analysis test available to eliminate confusion. 
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o Added valid content to System Performance test instructions window. 

o Support ticket fixes including a change to switch decode of log sense pages based on firmware rev 
to avoid wrong information in support ticket, a change to fix timestamp information for device 
analysis history log for LTO, and a fix to handle split support tickets from custom folders. 

o Added message on firmware update for SSL2020 library to notify that you need to enable firmware 
update via front panel for revs older than 4.09. 

o Fixed various L&TT crash problems including 1/8 autoloader when using Manual Product ID on 
Windows, selecting discovered library that can’t be opened, selecting firmware update options on 
Linux, and crash after running "Media Analysis" or "Read/Write" tests, or generating support tickets 
on Ultrium 2 SCSI.  

o Fixed “permission denied” problem on PA-RISC systems preventing L&TT from running. 

o Fixed “get files from web” problems, including no local firmware files showing on UNIX, unable to 
update cached revdata files on Windows preventing "Get files from web" from working, and 
erroneous update prompt for Ultrium EEPROM decoder on Windows, Linux, and HP-UX. 

o Changed NSR router firmware version decode to hex to handle alpha characters to enable 5.3.0b 
download. 

o Fixed L&TT hang with DLT acceptance test during loop 26 on HP-UX and Linux. 

o Fixed problem in support ticket for Ultrium 230 1/8 autoloader with H43r (and later) firmware where 
robotics errors would get displayed as "Error Type: Unknown." 

L&TT Version 3.4 (released November 2003) 

 Added device support for Universal VS80 and Autoloader 1/8 with Ultrium-2 drive. 

 Added new install and performance check functionality for Ultrium-1 and Ultium-2 drives 
for Windows 2K, XP, and 2003. 

 Internet connectivity added for Linux and HP-UX so features such as “get files from web” 
to download scripts and firmware, and the ability to send support tickets via email, are 
now available for these operating systems. 

 Various test/script enhancements: 

o Acceptance test is now the default whenever available for the device under test. 

o Added second generation test user interface for non-Windows platforms to provide test algorithm 
parameter options. 

o Added MO media validation test, and updated logic and messaging for setting Force Verify on MO 
Restore Factory Settings test. 

o Added tape stress test and acceptance test for Ultrium-1 and Ultium-2. 

o Device analysis drive rules improvements for Ultrium, DDS, DLT, MO, and ThinStor LTO 1/8. 

o FUP tape generation improvements for DLT products. 

o Revised Ultrium tape erase test to add support for DDS, and renamed test "Tape Erase Test." 

 

 Support ticket size management enhancements, including support for compression of 
support tickets, and splitting large library tickets to smaller, separate files to facilitate 
emailing and analysis. 

 Added capability to run .ssc script files on non-Windows platforms. 
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 Improved format of Ultrium logs to improve readability. 

 Improved capability to “skip-scan” on non-Windows platforms. 

 Fixed several L&TT defects: 

o Performance tool messaging on Windows 9x. 

o Library exerciser test timeouts. 

o Device analysis test failures on Compaq DLT1, support for blocks >64KB and not being able to 
identify if latest firmware was present. 

o Support ticket generation issues with Ultrium phase 5 FW, DAT 72 drives & MSL with 4.21 firmware. 
Also added test names to support ticket rather than just numbers (problem was introduced in V3.3). 

o L&TT crash fix when 1 or more library drives not recognized during scan (problem was introduced in 
V3.3). 

o TZ89 drives added to FUP creator script. 

o Acceptance test failures on non-Windows platforms. 

L&TT Version 3.3 SR1 (released September 2003) 

 Fix for issue on some HP-UX systems where L&TT would fail, referencing a missing 
liby.2 library file. 

 Fix for issue on NetWare where NWASPI.CDM would be loaded if available leading to 
possible server abends. 

L&TT Version 3.3 (released August 2003) 

 Several platform related changes: 

o Added support for Itanium CPU on all HP operating system platforms that support it (Windows 
Server 2003, HP-UX v11.x, Linux). 

o Integrated new I/O layer for NetWare based on Novell’s API’s rather than the previously used ASPI 
I/O layer, which improves reliability & discovery of devices. 

o HP-UX v10.20 no longer supported beginning with L&TT v3.3. 

o Added capability for parallel firmware updates on non-Windows platforms (HP-UX, Linux, and Tru64 
UNIX). Windows version has always had this feature. 

o Updated InstallShield for Windows for better support of newer Windows versions, and to improve 
compliance with software installation process required by Microsoft. 

o Integrated Skip-Scan function so user can limit scan to single device to avoid problems with other 
devices particularly in SAN environments. 

o Fix for problem on Tru64 UNIX that prevented L&TT from running on systems with older versions of 
C++ system libraries. 

 Several changes related to support tickets: 

o Enhancement for easier printing and comparison of support tickets created or viewed on Windows 
platforms. 

o Improved support ticket content for MSL5000 and MSL6000 running v4.18 or later firmware. Log 
contents now easily located in support ticket viewer with other data. 

o Fix for HTML version of support ticket to display ticket identifier. 
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o Fix for C7200 support ticket when fibre board present in library so it won’t be truncated. 

o Improved messaging for issues opening support tickets on Windows platforms. 

 Several changes in the test & scripts area: 

o Integrated several standalone performance tools into L&TT (HPTapePerf, HPCreateData, 
HPReadData, and PAT). 

o Released 2nd generation test functionality for library exerciser test and read/write test for Windows 
platforms. This allows the user to modify test parameters via the “Options” button in order to tailor it 
to a specific situation. 

o Fix for TSL-9000 device analysis failure on NetWare due to filename issue of rules file. 

o Several enhancements to scripts for SDLT220/320, DLT4000, Ultrium-1 and Ultrium-2, and MO 
drives. 

o Media migration utility has been discontinued with L&TT v3.3. 

 Miscellaneous device support changes and fixes: 

o Added support for universal VS80 and DDS drives 

o Added write back function for Ultrium drives for HP data retrieval & monitoring on returned drives for 
certain usage parameters (firmware updates, L&TT tests run, and so on). 

o Fix so L&TT correctly identifies OBDR support on Ultrium drives. 

o New firmware file format to handle SDLT220 requirement for upgrade based on drive serial number. 
New format will only be used with drives that have a requirement for such complex advance checks. 

o Fix to enable front panel function on C6280 autoloader. 

o Fix for firmware download hangs for DLT1 on NetWare (fixed with new I/O layer). 

L&TT Version 3.2 SR1 (released June 2003) 

 Miscellaneous test/script changes: 

o Added Acceptance test for VS80. 

o Added or enhanced several rules for Ultrium-1 device analysis scripts. 

o Updated full sweep test for C7200 and C7145 with firmware v1.60 to write test completion results 
back into picker assembly to help track usage and test data. 

o Fixed problem running device analysis test on Windows with more than one device selected that 
would give “parser error.” 

o Fix for problem where device analysis test would falsely prompt for drive exchange on early Ultrium-
2 drives. 

 Miscellaneous support ticket changes: 

o Added log decoding to support ticket for Windows viewer for Ultrium non-volatile EEPROMs. 

o Added decoding for C7200 & C7145 event codes 29, 30, and 31. 

o Fixed problem where trace banks were not included in Ultrium support tickets in “factory only” detail 
level. 

 Added personality code to all DDS firmware files to fix problem where Compaq 
personality was getting overwritten with SureStore personality on firmware download. 
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 Fixed problem where L&TT was unable to read cartridge memory in drives with pre-
released phase 5 firmware by revising command sequence to avoid timing problem. 

L&TT Version 3.2 (released May 2003) 

 Added Linux support (RedHat 7.2, 7.3 & 8.0) 

 Added support for various libraries and routers: 

o Support added for MSL 6000. 

o Support added for ESL 9000 and SSL 1016 with Ultrium-2 SCSI drives. 

o Support added for NS 1200-160, NS E1200-160, and NS E2400-160 routers. 

 Made several changes related to support tickets: 

o Added post decoding capabilities to support tickets (factory use only). 

o Changed support tickets saved in command shell to add .ltt extension. 

o Added temporary workaround to prevent L&TT hang or other abnormal behavior when reading data 
or support ticket with Ultrium-1 drives with E33Wor later firmware with cartridge loaded. 

 Several test/script changes: 

o Added Move Media functionality to Windows and command shell interfaces. 

o Added beta version of 2nd generation library exerciser test. 

o Added new device analysis script for Ultrium drives including device history log. 

o Added full release version of DLT acceptance test. 

o Updated Ultrium thermal analysis script. 

o Fixed device analysis script for DLT7000 that caused script error on Windows NT/2000 systems. 

o Fixed problem where device analysis firmware revision check for Ultrium-1 drives erroneously 
suggested invalid firmware upgrades. 

o Fixed problem where media validation test issued unnecessary unload command to DDS4 
autoloaders leaving cartridge in indeterminate state. 

o Fixed problem where status after running a 2nd test indicates wrong information. 

o Modified DLT FUP creation script to recognize all premerger Compaq drives & support VS80 drives. 

 Removed dependency on /usr/lib/liby.2 file on HP-UX 11.00 systems that caused L&TT 
core dump. 

 Fixed several L&TT defects: 

o Fixed cartridge information screen which showed unknown cartridge type for VS80. 

o Fixed L&TT crash caused by catalog file in wrong location. 

o Fixed problem where L&TT wouldn’t allow AIT firmware upgrade to v3.0G without factory password. 

o Fixed problem where drives in autoloaders were not properly associated with autoloaders on Tru64 
UNIX. 

o Fixed problem where firmware updates would timeout prematurely on Tru64 UNIX. 
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o Fixed problem where L&TT did not discover devices connected via fibre channel HBA on Tru64 
UNIX. 
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L&TT passwords 
A number of tool features are available only when enabled with a password. The password is intended to prevent 
inexperienced users from accessing functionality that may be particularly harmful to their system if used improperly. 
These features include: 

 Firmware downgrade: Lets you downgrade firmware revisions. The device product ID 
and revision string sequence must match in order for the downgrade to take place 

 Override/update product ID: Lets you select any firmware file (which matches the same 
device type) and update the product ID string (for devices which support this capability). 

 Manual product identification: Lets you override the tool mapping to associate a 
specific device (independent of Product ID) to a specific device family supported by the 
tool. This is most often used when the Product ID (SCSI Inquiry) string is incorrect 
because it has been changed, corrupted, or the device is running on boot code.  

 Factory details: Lets you select factory details anywhere it is an option. The most 
common use is in viewing additional device details in the support ticket 

 Advanced scripting: Disables signature checking and allows you to select 
"unsupported" devices and run scripts on them.  

 View event log — Lets you load (and view) an event log. 

Note: Two different types of passwords are used in L&TT: Temporary passwords and Support Personnel passwords. 
Temporary passwords enable users to downgrade firmware, and override/update product ID and manual product 
identification (mapping override). Support Personnel passwords are for internal hp use only and enable all the above 
options.  

To set passwords on Windows: 

Note: Passwords are only available by contacting HP support, and should only be used under the direction of HP support 
personnel.  

1. Select Options > enable factory overrides. 

The Factory Password dialog box opens. 

2. Enter the password, and then click OK. Assuming the password is valid, you can now 
access the password-protected functions of L&TT, subject to the above details 

To set passwords on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

Note: Passwords are only available by contacting HP support, and should only be used under the direction of HP support 
personnel.  

1. From the main screen, enter the preferences command. 

The Preferences screen opens. 
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2. Enter 6. 

L&TT prompts you for the current password. 

3. Enter the password. 

If the password is valid, L&TT returns you to the Preferences screen. You are now able to access the password-
protected functions of L&TT. 
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Library Front Panel function 
L&TT provides remote control of the front panel of selected library devices. It reads the contents of the front panel at 
regular intervals and displays the contents of the L&TT window either in graphic or text form. In addition, L&TT displays a 
representation of the library's front panel buttons. Clicking a button simulates pressing the corresponding button on the 
library's front panel.  

To access the Library Front Panel function: 

1. Select the library in the device list, and then click Frontpanel on the main toolbar. 

The Front Panel window opens. 
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Manual product identification 
This feature (which requires a password) allows an arbitrary device to be mapped as a specific device family within L&TT. 
This is most commonly used when the product ID (SCSI Inquiry string) does not match the string expected by L&TT. The 
string may have been changed or corrupted, or the product is operating in “boot code” mode. Passwords are only 
available by contacting HP support, and should only be used under the direction of HP support personnel.    

To manually identify a device: 

1. Click a product in the device list. 

2. Click Function > Manual Product Identification. 

3. Choose the product family that best matches the selected device (show me). Click here to 
view all product family choices: 

 Generic Tool 

 DDS Drive 

 SDT DDS Drive 

 DDS Autoloader 

 TSL DDS Autoloader 

 AIT-50 

 Ultrium Drive 

 DELL Library 

 DLT Drive 

 DLT Library 

 DLT1 Library 

 MO Drive  

 MO Library 

 STK 9840 Drive 

 STK Library 

 ESL Library 

 Crossroads Bridge 

 4Runner Bridge 

 Safe-TE Enclosure 

 Fibre Channel Interface 

 LTO Library 

 Neo Series Library 
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 AIT Drive 

 UHDL Autoloader 

 TL895 Library 

 DLT/SDLT/DLT1 Drive 

 DLT/Ultrium Library 

 1/8 DLT Autoloader 

 1/16 DLT Autoloader 

 1/8 Ultrium Autoloader 

 AIT Library 

 AIT Autoloader 

 MSL Library 

 TL89x Library 

 SCSI-FC Bridge 

 Interface Manager 

 ESL E-Series 

 

 

 Note: For L&TT versions prior to v2.7 SR2a, manual product identification (previously called override mapping) was 
performed by right-clicking the device in the device list and choosing the appropriate product family. 

When manual product identification is enabled, L&TT automatically operates in a restricted mode. In this mode, the 
firmware update options are pre-selected to enable selection of firmware for any product ID; the “Update Product ID” 
option is also enabled. To update the product ID, select the proper firmware file and click the Start Update button. 
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Move Media function 
Most supported libraries and autoloaders support a set of commands for moving media from one location to another within 
the device. Whenever possible, L&TT takes advantage of this functionality to provide a convenient way to move media 
within a library or autoloader. This functionality is supported in both Windows and non-Windows configurations. 

 

Windows 

On the Windows version of L&TT, the Move Media functionality is incorporated into the Front Panel window. 

To access the Move Media function on Windows: 

1. select a supported library or autoloader from the device list, and then click Frontpanel on 
the main toolbar. 

Note: If both the Move Media and Front Panel functions are dimmed, these functions are not supported for the 
selected device). 

2. In the Front panel window, click the Move Media tab. 

The Move Media window opens. The Move Media window is divided into two sections showing all available 
source and destination drives, slots, and mailslots. 

 

3. To move media from one location to another, select the desired source and destination 
locations, and then click Perform move. 

Note: You can only move one item at a time, so it is not possible to select multiple source or destination 
locations. The Perform move button is dimmed until a valid source and destination have been selected.  
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HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

To access the Move Media function on HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX: 

1. In the Device Information screen, enter the movemedia command. 

The Move Media screen is displayed. This screen is identical to the cartridge inventory screen accessed with the 
inventory command, with the exception of the screen name shown in the top line. 

2. Use the  ^U and ^D commands to scroll through the list. 

3. To perform the move, use the move command as follows: 

Move  <source>  <destination> 

The values used for “source” and “destination” are a combination of the letter “s” for slot, “d” for drive, or “m” for 
mailslot, and then the number of the device. Observe the following examples: 

Example 1:  

Observe the following Move Media screen and note the status of slots 3 and 4.  

 

Now issue the following move media command: 

move s4  s3 

If you view the Move Media screen again, the status of these two slots has changed in accordance with the issued 
command.  
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T  

Example 2:  

If you use the same library as in Example 1, and want to move media from Drive 1 to Mailslot 3, use the following 
command: 

move  d1  m3 

The following Move Media screen is displayed.  

 

 

Possible Move Media Error Situations 

The following errors may be encountered when attempting to move media through L&TT: 

Note: these errors are less common with the Windows version of L&TT because the user interface reduces the number of 
possible error situations 
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 Source is empty. 

 Destination is full. 

 Picker is full with some other media. 

 Source and destination are the same. 

 Invalid arguments were provided (for example, the slot number is too high  or no mail 
slots on the system). 

 Slot to slot is not supported with this device (you must move slot to drive or drive to slot). 

 Command was acceptable, but there was a SCSI error performing the move. L&TT 
provides the SCSI error message along with the sense data 
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Quiet mode 
When L&TT is run in Quiet mode, warning and error dialog boxes are not displayed, depending on the quiet mode 
argument that you specify. Quiet mode has two possible arguments: 

 Warning: When the warning argument is specified, L&TT does not display any warning 
dialogs. L&TT assumes a "yes" response to all warning dialogs and proceeds with 
execution. 

 Error: When the error argument is specified, L&TT does not display warning or error 
dialogs. L&TT assumes a "yes" response to all warning and error dialogs and proceeds 
with execution. 

 

CAUTION: A filing cabinet is a good analogy for a database structure. The file room is where all the file 
cabinets are stored; this to be the database. The file cabinets each hold specifically organized information 
(for example, one cabinet may store employee information, another may house equipment information); 
these file cabinets are the tables. Within each file cabinet, there are file folders, each containing very 
specific parcels of information (for example, employee resumes or equipment receipts); these are the fields. 
Put it all together and you have the basic structure for a database. 
   HP Does not recommend using quiet mode unless you are thoroughly familiar and experienced with L&TT. 
Quiet mode makes using L&TT more convenient by suppressing warning, error, and confirmation dialogs. 
However, these same warning, error, and confirmation dialogs are intended to provide an extra level of 
security to prevent you from accidentally doing something that you did not intend to do. Using quiet mode 
sacrifices this extra level of security for convenience. 

To enable Quiet mode: 

1. Launch L&TT from a command prompt using the "quietmode=[error|warning]" argument.  

 To launch the Windows version of L&TT with quiet mode enabled, click start > 
run and enter the following into the run dialog box: 

"C:\Program Files\HP StorageWorks Library and Tape Tools\HP_LTT.exe"  -o 
quietmode=[error|warning] 

Note: Be sure to include the quotation marks as indicated, or the pathname will be invalid. 

 For HP-UX, Linux and Tru64 UNIX, log on as root and execute the following: 

cd  /opt/ltt 

./hp_ltt  -o quietmode=[error|warning] 

 For Novell NetWare, execute the following from the server console: 

hp_ltt\hp_ltt  -o quietmode=[error|warning] 

 For OpenVMS, log in as "system," and then execute the following: 

o Navigate to the "[000000.sys0.syscommon.opt.ltt] directory, and then enter the following: 

"run HP_LTT.EXE  -o quietmode=[error|warning] 
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Restricted mode 
When running in restricted mode, only a few L&TT features are available. Running in restricted mode is not a user option, 
but rather a condition that exists automatically if L&TT recognizes a supported device that has a problem with firmware, 
and requires a firmware upgrade. There are two basic scenarios that can cause this to happen. 

 L&TT recognizes the device, but the device is in "brain dead" mode. This usually 
indicates that the device firmware is corrupt and the device is responding via boot code 
only. 

 L&TT recognizes the device by means of the product ID code, but L&TT does not 
recognize the "personality" codes of the device. 

Restrictions 

If one of these scenarios exist, L&TT displays a message stating that it is running in restricted mode when it is started. 
The functionality of L&TT is then restricted as follows: 

 All features are disabled except for firmware update and support ticket. 

 The support ticket shows basic information only and excludes device details. 

 For firmware upgrades, L&TT enforces the "allow all files to be selected" option and the 
Options button is unavailable because all options are preset. 

Exiting Restricted Mode 

To exit restricted mode, exit and restart L&TT. Please note that L&TT will continue to start in restricted mode until the 
problem with the offending device is resolved, or the device is disconnected. 

One way to get more details about what is causing restricted mode operation is to turn on I/O history, then generate and 
send the event log to hp support for analysis. If it is suspected that the issue is related to product ID, see also Manual 
product identification. If it is suspected that the drive is "brain dead" or the firmware is otherwise corrupt, try reflashing 
drive firmware. 
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Running L&TT from CD-ROM (Windows only) 
If the user insists on not installing L&TT and is running Windows NT or 2000, inform them they can run L&TT from the CD-
ROM without reboot, rather than install it on their server. 

 If another Windows system is available with a CD burner, install L&TT on that Windows 
system. Beginning with L&TT v3.5 SR1 you can no longer get script updates from the 
web. Make sure to install the latest available version of L&TT as well as any pertinent hot 
fixes or other updates to ensure  that you have the latest scripts. You should also obtain 
any available firmware updates prior to burning the CD-ROM, because you cannot obtain 
these updates when running from CD-ROM. 

 Remove logs directory from L&TT install directory. 

 Write content of L&TT install directory to root directory of CD-ROM and close CD-ROM. 

 Put CD-ROM into any Windows system and run HP_LTT.exe from the root directory. 

 Can also run from CD-ROM on other windows systems, but will need ASPI installed, 
which will cause a reboot. 

Note:  Running from CD-ROM is not currently supported on other operating systems. 

Note: The "run from CD-ROM" feature does not work with L&TT v3.5. Download and install L&TT 3.5 SR1 to 
correct this problem. 
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Support for the L&TT tool 
Email support is available from ltt_team@hp.com for the L&TT tool. You can expect a response within 24 hours (usually 
sooner) during a normal business week. Use this address to obtain support for L&TT, to report bugs, to report any issues 
with the L&TT web site, or to provide L&TT enhancement suggestions. 

The HP L&TT team appreciates feedback on how to make improvements for future versions of L&TT. If submitting 
information on a problem, please include problem details and L&TT Event Logs in the email message. Click here for 
information on generating event logs for Windows, and here for information on generating event logs on other supported 
operating systems. 

Note: This address is intended to provide support for L&TT software only. This address is NOT for assistance in 
troubleshooting hardware products. Users should refer to the documentation that comes with their hardware for support 
options for that product. 
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Tool Status Report  
The Tool Status Report (TSR) is a feature of L&TT that is used to help understand and debug problems with the L&TT 
tool. Contents of the TSR include configuration info, stack trace, other system info, and so on. It is automatically 
generated any time the L&TT application is unexpectedly shut down, but can also be manually generated if necessary to 
get more information about system config, and so on.  

The only difference in the contents of manually-generated and automatically-generated reports is that the manually 
generated report contains no stack trace (at the time of generation) or register values. The TSR feature is supported on 
Windows and non-Windows platforms. 

 

Windows 

To manually generate a Tool Status Report on Windows: 

1. From the L&TT main window, click Help > Tool Status Report. 

The Tool Status Report window opens. 

 

b. Step 1: Enter any details that may help the L&TT team. 
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c. Step 2: Click the check box to allow the L&TT team to contact you if they need further details. They will not 
contact you for any other reason. 

d. Step 3: Click the Send as E-Mail button to send to the default L&TT team address, unless otherwise 
directed by HP support personnel. If you want to view the report prior to emailing it, click the Preview 
button before clicking Send. 

Note: Before L&TT can email a TSR, you must either have a MAPI-compliant e-mail program (such as Microsoft 
Outlook or Outlook Express), or you must set up an email account through the Windows Control Panel or Internet 
Explorer. For more information about setting up an email account, see To set up an email account on Windows. 

2. If for some reason you decide not to send the report, click Cancel to return to the L&TT 
main screen.  

 

HP-UX, Linux, NetWare, OpenVMS, or Tru64 UNIX 

To manually generate a Tool Status Report on HP-UX, Linux, NetWare, OpenVMS, or Tru 64 UNIX: 

1. In the L&TT Main screen, enter the report command or press Enter to launch the 
Command Help screen (showing all available commands), and then enter the report 
command from there. 

 

Note: You can also enter the report command from the Device Identity or Device Information screens (show 
me). 
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 This generates a TSR and displays the Tool Status Report screen. 

 

2. Complete the items in the Tool Status Report screen: 

 Enter 1 if you want to enter additional details to the L&TT support team. After 
entering 1, a new screen opens containing the entire text string for option 1, as well 
as an option to enter text by typing yes or no. 
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 Enter 2 if you want to allow the L&TT support team to contact you if they need 
further details.  After entering 2, a new screen opens containing the entire text string 
for option 2, as well as an option to give permission (yes) or not (no) to contact you. 
The L&TT support team will not contact you for any other purpose than to get more 
information on the report. 

 

 Enter 3 if you want to send the status report to an email address other than the 
default L&TT support team address (ltt_team@hp.com) (show me). Use the default 
address unless otherwise instructed by HP support personnel. 
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3. To view the report prior to emailing it, enter the Preview command. When previewed, the 
Tool Status Report is opened in the “vi” editor so it can be edited with normal commands 
of “vi,” if necessary. 

 

4. To send the TSR via email, return to the previous TSR screen and enter sende-mail. 
This sends the TSR to the default email address of ltt_team@hp.com (unless you have 
previously changed it). After the email has been sent, the device identity screen appears 
once again. 

5.  As you can see, this TSR was not generated as a result of an L&TT crash as indicated 
by the “no error” text in the TSR heading. 



 

197 

Miscellaneous Information 

Backup software support links 
Click the links below to view support information for the various backup software applications. The main application 
support web site is provided for each of the applications, along with links to some specific known application issues, when 
available. 

Veritas (Backup Exec and Netbackup) 

 general support @www.veritas.com/support 

 specific issue information: 

o CRC errors with Backup Exec 

Computer Associates (ARCserve/Brightstor) 

 general support @www.ca.com/support 

 specific issue information: 

o Poor backup performance with HP DLT VS80 and Brightstor v11 

If backups are very slow and the hardware and media is believed to be ok, try the following to improve backup 
performance: 

 Stop the "CA Brightstor Tape Engine" service and locate the following registry 
folder using Regedt32.exe: 

HKLM/Software/Computer Associates/Brightstor ARCserve 
Backup/Base/TapeEngine/DEVICE#/ 

 Look at the Info value for the device# that corresponds with your DLT drive, then 
ADD DWORD value 

data type=Reg_Dword 

valuename=DefaultBlockFactor 

data=7, HEX 

 Restart the "CA Brightstor Tape Engine" service. File backup should now be 
much faster. 

Legato (NetWorker) 

 general support @www.legato.com/support 

 specific issue information: 

o If links to information are determined in the future, they will be provided in a subsequent release of the support 
guide. 

Yosemite (Tapeware) 

 general support @www.tapeware.com/support 

 specific issue information: 

o If links to information are determined in the future, they will be provided in a subsequent release of the support 
guide. 

Tivoli 
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 general support @www.tivoli.com/support 

 specific issue information: 

o If links to information are determined in the future, they will be provided in a subsequent release of the support 
guide. 

NovaStor (Novaback) 

 general support @www.novastor.com/techsupt.html 

 specific issue information: 

o If links to information are determined in the future, they will be provided in a subsequent release of the support 
guide. 

HP Data Protector 

 General support @ http://www.hp.com/cgi-bin/hpsupport/index.pl 

 Specific issue information 
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Device-specific information 
Product-specific information links are occasionally changed or removed, so to avoid broken links, no product-specific links 
are provided here. For online documents that contain information pertaining to specific products, go to www.hp.com and 
navigate to the support page for the product. 

Attention UDO users running HP-UX: The UDO drive (AA961A) reports a blank check condition when attempting to 
read blank sectors. The HP-UX file system does not know how to respond to a blank check condition. As a result, any 
attempt to perform a "newfs" on a new piece of UDO media results in an error message ("mkfs failed"). To resolve this 
issue, a script is available to revise the UDO mode page. To obtain this script, contact the L&TT team at 
ltt_team@hp.com. After this script (UDO_Blank_Config.tst) has been run, the UDO drive no longer reports a blank check 
condition when attempting to read blank sectors, but it will return the data as being all zeroes for the blank sector. 
 
Note: This script should only be used on HP-UX file systems in which native file system support will be used. Do not run 
the script if the UDO drive will be run with ISV software because it is likely to cause that software to fail. This issue is 
applicable to R/W media only (WORM media is not impacted). The UDO drive must be empty when the script is run (the 
script issues a prompt to remind you). Settings resulting from running the script are retained unless the page is explicitly 
reset via the "Reset factory settings test."   
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Miscellaneous useful links 

 Product bulletin web site link  
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Miscellaneous Windows links 

 Tape Drive Detection and Other Considerations in Windows NT 4 and 2000 operating 
systems  
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Miscellaneous product troubleshooting reference information 

External interactive troubleshooting content: 

 Ultrium 215 

 Ultrium 230 

 Ultrium 460 

 DAT 8, DAT 24, DAT 40 & DAT 72 

 DAT autoloaders 

 SDLT 220/320 

Other miscellaneous product troubleshooting information: 

For online documents that contain information that may be helpful in troubleshooting problems with a particular product, 
go to www.hp.com and follow the links for your specific product. 
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